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ค าน า  

      Pilot project การจดัท าหนงัสือหายากอิเล็กทรอนิกส์ในโครงการหนงัสือหายากออนไลน์ : E-
text  ของศูนยว์ทิยทรัพยากร เป็นโครงการริเร่ิมการจดัท าหนงัสืออิเล็กทรอนิกส์ดว้ยการใชก้ลอ้งดิจิทลั           
เพื่อถ่ายทอดประสบการณ์การท างานและผลงานของโครงการฯใหเ้ป็นท่ีประจกัษ ์ขา้พเจา้ในฐานะ
ผูป้ฏิบติังานไดร้วบรวมขั้นตอนงานและผลส าเร็จแห่งงานจดัท าเป็นขอ้เขียนสองบท บทท่ี 1 วา่ดว้ยการ
จดัท าหนงัสืออิเล็กทรอนิกส์ในโครงการ หนงัสือหายากออนไลน์ : E-text   และบทท่ี 2 วา่ดว้ยผลงาน
ภาพหนงัสือหายากอิเล็กทรอนิกส์  และบทท่ี 3 ผลการทดลอง งานซ่ึงกล่าวถึงการทดลองจดัท าหนงัสือ
หายากอแล็กทรอนิกส์แบบต่าง ๆตามท่ีไดเ้สนอแนะในบทก่อนหนา้ นอกจากน้ี ยงัน าเสนอขอ้มูล
ทั้งหมดน้ีในรูปส่ิงพิมพแ์ลว้ ผูส้นใจสามารถศึกษาจากผลงานน้ีทางอิเล็กทรอนิกส์ใน CUIR ไดด้ว้ย  

เม่ืองานถ่ายภาพริเร่ิมความคิดในการใชก้ลอ้งดิจิทลัถ่ายท าหนงัสือหายากของหอสมุดกลาง 
ศูนยว์ทิยทรัพยากรนั้น การใชก้ลอ้งถ่ายภาพถ่ายท าหนงัสือยงัไม่ใช่วธีิการท่ีใชก้นัแพร่หลาย ส่วนใหญ่
นิยมใชก้ารกวาดสัญญาณภาพเป็นไฟล ์ดว้ยเคร่ืองกราดสัญญาณ (flatbed scanner) หากเน่ืองดว้ย
ทรัพยากรสารสนเทศของหอสมุดกลางเป็นทรัพยสิ์นทางปัญญาท่ีมีทั้งคุณค่าและราคา ปฏิบติัการใดกบั
ตวัเล่มหนงัสือควรตอ้งใชค้วามระมดัระวงัเป็นอยา่งยิง่ท่ีจะไม่ท าร้ายลกัษณะทางกายภาพ การใชก้ลอ้ง
ถ่ายภาพจึงเป็นทางเลือกท่ีดีท่ีสุด แต่ส าหรับผูป้ฏิบติังานแลว้ งานน้ีนบัเป็นงานท่ีทา้ทายความสามารถ 

      เน่ืองจากโครงการน้ีเป็นโครงการน าร่องเพื่อน าการผลิตหนงัสืออิเล็กทรอนิกส์ดว้ยการ
ถ่ายภาพ  ระหวา่งด าเนินการช่างภาพตอ้งใชท้ั้งศาสตร์และศิลป์เพื่อใหง้านบรรลุผลตามวตัถุประสงค ์
เร่ิมจากการประสานงานท่ีดีระหวา่งทีมงาน (ทั้งศูนยโ์สตทศันศึกษากลาง และหอสมุดกลาง) การ
ประมวลประสบการณ์และความรู้ในงานถ่ายภาพท่ีมีอยูแ่ละท่ีตอ้งศึกษาเพิ่มเติม มาดดัแปลงเคร่ืองมือ
และวธีิการท่ีเหมาะสมเพื่อใหไ้ดผ้ลงานภาพท่ีดีท่ีสุด  ตลอดขั้นตอนการเตรียมงาน การปฏิบติังานและ
การเรียงร้อยผลงานให้เป็นช้ินงานพร้อมบริการนั้น ลว้นเป็นผลจากวริิยะ อุตสาหะ และความมุ่งมัน่ของ
ผูร่้วมงานทุกคน ผลส าเร็จแห่งงานไม่เพียงเป็นความภูมิใจของผูป้ฏิบติังานเท่านั้น  โครงการน้ียงัเป็น
ตน้แบบเพื่อการศึกษาส าหรับงานหนงัสืออิเล็กทรอนิกส์ส าหรับองค์กร/สถาบนัอ่ืนๆ ดว้ย  

          ประโยชน์อนัพึงเกิดจากความรู้ของผลงานน้ี ขอมอบแด่ผูป้ฏิบติังานโครงการฯทุกท่าน รวมทั้ง
ศูนยว์ทิยทรัพยากรท่ีเปิดโอกาสใหผู้ป้ฏิบติังานไดใ้ชค้วามรู้ความสามารถสร้างผลงานไดเ้ตม็ท่ี 
ขอ้บกพร่องใดใดในงานน้ี ขา้พเจา้ขอนอ้มรับเพื่อปรับปรุงแกไ้ขใหง้านสมบูรณ์ต่อไป         
          ชชัวาล   ศรีสละ 
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บทที ่ 1  
การจัดท าโครงการ 

 

การจัดท าหนังสืออเิลก็ทรอนิกส์ 

 สําหรับบรรณารักษ์และ/หรือประชาคมห้องสมุดนั้ น เม่ือเอ่ยถึงเร่ืองราวของหนังสือหายาก 
ความคิดจะมุ่งไปท่ีเร่ืองการอนุรักษ์เป็นลาํดับแรก เน่ืองจากในวงวิชาชีพบรรณารักษ์ทุกคนทราบดีว่า 
หนงัสือหายากเป็นทรัพยากรสารนิเทศท่ีมีค่าในเชิงประวติัศาสตร์  ส่วนใหญ่เป็นหนงัสือท่ีมีอายุมาก สภาพ
หนังสือไม่พร้อมให้บริการชั้ นเปิด  ดังนั้ นหน่วยงานบริการสารนิเทศส่วนใหญ่ท่ีมีหนังสือหายากใน
ความหมายน้ี จึงมีการจดัการสารนิเทศแบบชั้นปิดและเน้นท่ีการอนุรักษ์/รักษาหรือคงสภาพสารนิเทศ
เหล่านั้น  

เม่ือกระบวนการทางอิเล็กทรอนิกส์เขา้มามีบทบาทในงานห้องสมุด หน่วยงานบริการสารนิเทศ
หลายแห่งเร่ิมใชก้ารแปลงส่ือเป็นดิจิทลั (digitization) เพื่อการให้บริการสารนิเทศ และการอนุรักษ์  ในปี 
2546 หอสมุดกลางและศูนยโ์สตทศันศึกษากลาง ศูนยว์ิทยทรัพยากร โดยงานถ่ายภาพไดเ้ร่ิมโครงการนาํ
ร่องในการอนุรักษห์นงัสือเก่าหรือหนงัสือหายากท่ีจดัเก็บท่ีหอ้งกรมพระจนัทบุรีนฤนาท หอสมุดกลาง โดย
ใช้การถ่ายภาพดิจิทลัถ่ายภาพหนงัสือหายากเหล่านั้นเพื่อการคงสภาพตวัเล่ม และให้ใชบ้ริการในรูปไฟล์
ดิจิทลัแทน 
 งานถ่ายภาพซ่ึงเป็นผูรั้บผิดชอบโดยตรงในกระบวนการทางเทคนิค มีหน้าท่ีในการประสานงาน
การถ่ายภาพตั้งแต่เร่ิมโครงการ โดยรับผิดชอบการถ่ายภาพหนงัสือหายาก ซ่ึงเป็นหนงัสือเก่า สภาพรูปเล่ม
ไม่สามารถใช้การสแกนภาพได้ เพราะจะทาํให้หนังสือชํารุดเสียหาย หนังสือเก่าหรือหนังสือหายาก
เหล่านั้นตอ้งใชค้วามพิถีพิถนั ค่อยพลิกทีละหนา้ จดัตน้ฉบบัเล่มหนงัสือให้อยูใ่นตาํแหน่งท่ีจะถ่ายไดภ้าพท่ี
คมชดัท่ีสุดเท่าท่ีจะเป็นไปได ้และให้มีความสมํ่าเสมอเท่ากนัทุกหนา้ ทุกบทและทุกตวัอกัษร ลกัษณะการ
จดัถ่ายเช่นน้ีสอดคลอ้งกบัการจดัถ่ายงานภาพตน้ฉบบั วสัดุ ส่ิงของ ปฏิบติัและรับผดิชอบอยู ่การดาํเนินงาน
ทั้งหมดตอ้งมีการทดลองทาํเป็นโครงการนาํร่อง (pilot project)  รวมหนงัสือหายาก จาํนวน 28 เล่ม และ
รายงานกิจการของจุฬาลงกรณ์มหาวิทยาลยั ปี 2540 และ 2541 (2 เล่ม) จากนั้นไดน้าํข้ึน website ของศูนย์
วทิยทรัพยากร เป็นบริการหนงัสือหายากออนไลน์  
 ในการดาํเนินงานตามโครงการน้ี งานถ่ายภาพถ่ายภาพจากหนังสือหายากท่ีให้บริการในห้อง
หนงัสือหายากของหอสมุดกลาง รวม 30  เล่ม (2990 หนา้) ผูส้นใจศึกษาขอ้มูลเพิ่มเติมเก่ียวกบัหนงัสือหา
ยากของหอสมุดกลาง สามารถเขา้ดูไดท่ี้  http://www.car.chula.ac.th/web/form/resources/ หรือสามารถ
ติดต่อใชบ้ริการเล่มจริงไดท่ี้หอ้งหนงัสือหายาก หอสมุดกลาง ศูนยว์ทิยทรัพยากรชั้น 6 
           สําหรับรายละเอียดทางบรรณานุกรมของผลงานเหล่าน้ีปรากฏตามเอกสารในบทต่อไป
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การด าเนินงาน การจัดท าหนังสืออเิลก็ทรอนิกส์ 
 
เร่ิมจากการคดัเลือกหนังสือเพื่อการถ่ายภาพนั้น บรรณารักษ์จะคดัเลือกหนังสือหายากเล่มท่ีมี

คุณภาพดี และช่างภาพตอ้งสํารวจอีกคร้ังว่าสภาพหนงัสือสมบูรณ์ไหม?  มีหน้าครบทุกหน้า และตอ้งวาง
แผนการถ่ายภาพ บางเล่ม หนา้หนงัสือมีเฉพาะหนา้ขวา  บางเล่มมีทั้ง 2 หนา้ บางเล่มเร่ิมตน้ดว้ยเลขหนา้ 1, 
2, 3 บา้ง เป็นอกัษร ก ข ค บา้ง บางเล่มมีหนา้พบัซ้อนขยาย เช่น หนา้ตารางหรือกราฟ หรือแผนท่ี ซ่ึงทาํให้
ปฏิบติังานไดย้าก ส่ิงท่ีควรระวงัท่ีสุดคือ สภาพท่ีหนงัสือหายากท่ีมีอายเุก่าและเส่ือมตามสภาพใชง้าน  และ/
หรือกรอบมาก ๆ เม่ือช่างภาพถ่ายไปและพลิกไปทีละหน้าแผ่นกระดาษในหนังสืออาจจะกรอบและหัก
ชาํรุดเสียหายได ้
 
ขั้นตอนเตรียมการเพือ่การถ่ายภาพ 
 วธีิการใหไ้ดม้าซ่ึงภาพดงักล่าว ช่างภาพเรียกวา่ เป็นการถ่ายก็อปป้ีภาพ  ภาพท่ีจะถ่ายก็อปป้ีอาจจะ
เป็นภาพจากหนงัสือ ภาพเขียน ตวัหนงัสือ ภาพลายเส้น ฯลฯ  ก็ได ้ในการถ่ายก็อปป้ีภาพดงักล่าว จะขอ
อธิบายเคร่ืองมือทางการถ่ายภาพเพื่อใหเ้ขา้ใจกระบวนการทาํงานได ้ ดงัต่อไปน้ี 

1. กลอ้งและเลนส์ถ่ายใกล ้
2. แท่นก็อปป้ีภาพ (Copy stand) 
3. ไฟส่องสวา่ง 
4. สายลัน่ไกชตัเตอร์  
5. ขาตั้งกลอ้ง 
6. กระดาษสีดาํ                
7. กระจกดา้น (Matte mirror) 

 
 
การใช้อุปกรณ์ เคร่ืองมือและวธีิการปฏิบัติงานการถ่ายภาพหนังสือหายาก 
 
1. กลอ้งและเลนส์ถ่ายใกล ้

 เน่ืองจากปัจจุบนักลอ้งดิจิทลัมีบทบาทในงานถ่ายภาพมากเพราะใชง้านไดส้ะดวก (เม่ือเทียบกบั
การอนุรักษใ์นสมยัก่อนโดยใชไ้มโครฟิลม์) กลอ้งดิจิทลัมีหลายรูปแบบและมีใหเ้ลือกหลายรุ่นหลายขนาด
ในการถ่ายภาพหนงัสือหายากทีละหนา้ ขอ้แนะนาํในการเตรียมกลอ้งดิจิทลัในลกัษณะของงานอนุรักษ ์ควร 
เลือกชนิดกลอ้งดิจิทลัชนิดท่ีสามารถถอดเปล่ียนเลนส์ได ้เน่ืองจากตอ้งใชเ้ลนส์ แมคโคร ซ่ึงเป็นเลนส์ท่ีมี
ความสามารถในการถ่ายภาพระยะใกลก้บัวตัถุมากๆ ได ้เพื่อใหไ้ดภ้าพถ่ายท่ีคมชดัทุกระนาบองศา  
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กลอ้งดิจิทลั มาจากคาํภาษาองักฤษวา่ Digital single lens reflex (DSLR) คือ กลอ้งดิจิทลั สะทอ้นภาพแบบ
เลนส์เด่ียว กลอ้งแบบน้ี มีหลายฟอร์แมตดว้ยกนั ฟอร์แมตท่ีนิยมโดยทัว่ไปคือ 35 DSLR และฟอร์แมตน้ีก็
จะมีกลุ่มเลนส์ใหเ้ลือกใชม้ากมาย ทั้งเลนส์ปกติ เลนส์มุมกวา้ง เลนส์ดึงภาพ (Zoom) เลนส์ถ่ายภาพ
ระยะไกลรวมทั้งเลนส์แมคโครดว้ย 
กลอ้งท่ีงานถ่ายภาพเลือกใช ้คือ กล้อง NIKON  รุ่น D100  เป็นกลอ้งดิจิทลัขนาดฟอร์แมต 35 DSLR ให้
ไฟลไ์ดห้ลายรูปแบบ  SPEC กลอ้งดิจิทลัรุ่น NIKON  D 100 ดงักล่าวน้ี มีนํ้าหนกัเบา  มีความทนทาน 
คล่องตวั มีความเหมาะสมในการใชง้าน   ไฟลภ์าพจากกลอ้งจะเป็นไฟลภ์าพขนาดใหญ่ (มากถึง  6.31  ลา้น
พิกเซล) และเป็นไฟลภ์าพ Jpeg  และ Tiff  เม่ือถ่ายโอนไปยงัคอมพิวเตอร์ มีคุณภาพในระดบักลอ้งโปร   
Nikon  D 100 ใช ้ CCD  ขนาด 23.7 x 15.6 มม.   มีค่าไดนามิกเร้นจก์วา้ง  เก็บรายละเอียดไดดี้     ทั้งสีท่ีมี
คอนทราสตแ์ละความคมชดั  กลอ้ง Nikon  D 100   มีโหมดสีใหเ้ลือก 3 แบบ ตามความเหมาะสมของงาน 
คือ  1) Mode  sRGB   ช่วงของโทนสีกวา้ง  สีดูเป็นธรรมชาติ  สีผวิของบุคคล  เหมาะงานถ่ายภาพบุคคล    
      2) Mode  Adobe  RGB  ช่วงกวา้งสีมากท่ีสุด  ไฟลภ์าพสีมีคุณภาพสูง  สาํหรับงานถ่ายภาพเชิงพาณิชย ์ 
เช่น สินคา้หรือจดั Subject   และ  prop  ใน Studio  และ     
      3) Mode   sRGB  Optimised  ความอ่ิมตวัของสีสูงเป็นพิเศษสาํหรับถ่ายภาพทิวทศัน์  ธรรมชาติ  
 
รายละเอยีดและคุณลกัษณะกล้องดิจิทลั  Nikon  D 100 
 กลอ้งดิจิทลัมีความละเอียด  6.31  ลา้นพิกเซล,  ความไวแสงสูงสุด  ISO 200 – 6400,  จอ LCD  
ขนาด 1.8 น้ิว , นํ้าหนกั 730  กรัม, มีคุณลกัษณะของกลอ้ง  (Specification) ดงัน้ี 
ความละเอียด 6.31 Mpixel 
ขนาดภาพสูงสุด 3008x2000 
ขนาดภาพเล็กสุด 1504x1000 
ขนาดเซ็นเซอร์ 23.7x15.5 mm 
เซนเซอร์ CCD 
ตวัคูณโฟกสั 1.5 
ซูมเลนส์ n/a 
ซูมดิจิทลั No 
ระบบโฟกสัอตัโนมติั Yes  
ระบบแมนนวลโฟกสั Yes 
ความไวแสง auto,200-1600,3200,6400 
โหมด  Aperture  priority Yes  
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เลนส์ถ่ายใกล ้
 เลนส์ของกลอ้ง NIKON มีใหเ้ลือกมากมาย แต่เลนส์ท่ีนาํมาถ่ายก็อปป้ีนั้น  ควรเลอืกใช้เลนส์แมค
โคร (MACRO LENS) เน่ืองจากเลนส์แมคโครถูกออกแบบใหโ้ฟกสัไดม้ากกวา่เลนส์ปกติ ทาํใหส้ามารถ
ถ่ายภาพวตัถุท่ีมีขนาดเล็กมาก ๆได ้ ทาํใหไ้ดอ้ตัราขยายสูงๆ  เลนส์แมคโครจึงเหมาะสมในการนาํมาถ่ายก็
อปป้ีภาพ โดยเฉพาะหนา้กระดาษหนงัสือหายาก เพื่อเก็บรายละเอียดของตวัหนงัสือไดดี้ ยิง่หากเป็น
ตวัหนงัสือท่ีมีวธีิพิมพแ์บบเก่า ซ่ึงใชต้วับล็อกตะกัว่ท่ีบางคร้ังความคมชดัของหมึกพิมพบ์นตวัตะกัว่ไม่
สมํ่าเสมอ  เลนส์แมคโครท่ีมีคุณภาพจะเก็บรายละเอียดเหล่าน้ีไดดี้ทีเดียว ดว้ยเหตุท่ีวา่เลนส์แมคโครมีคุณ
ลกัษณะเฉพาะ คือ แมคโครนั้นหมายถึง การถ่ายภาพวตัถุท่ี Life size คือ 1: 1 นัน่คือ ไดภ้าพวตัถุท่ี
อตัราส่วนของภาพในขนาดเท่าจริง  อตัราส่วน 1 :1 มีความหมายวา่  สามารถถ่ายภาพไดข้นาดภาพในฟิลม์
เท่ากบัขนาดของวตัถุ  ส่วนอตัราส่วน  1 : 2  หมายถึง  ขนาดภาพในฟิลม์เท่ากบัขนาดคร่ึงหน่ึงของวตัถุ1  
(ในปัจจุบนัคงกล่าววา่  ภาพบน  CCD  หรือภาพบน  CMOS)  เลนส์แมคโครแท ้ๆ คุณภาพดี จะมีระยะ
โฟกสัใกลสุ้ดมาก ๆ นัน่คือ  ระยะท่ี 1:1 และ 1:2 (ในปัจจุบนัเลนส์แมคโครรุ่นใหม่มกัทาํระยะท่ี 1:1)   

การประเมินในเร่ืองของความคมชดัของการถ่ายภาพตวัหนงัสือในหนงัสือหายากนั้น เลนส์แมค
โคร 1:1 จะใหค้วามคมชดั (ความชดัลึก) ท่ีต้ืนมาก (แต่ในระยะโฟกสัท่ีเจตนาใหช้ดัและช่างภาพโฟกสัได้
ชดันั้น จะมีความคมชดัมาก)  การเลือกจุด(ตาํแหน่ง)โฟกสัในการใชง้านเลนส์แมคโคร จึงตอ้งระมดัระวงั
มาก  การโฟกสัท่ีผดิพลาดไปเล็กนอ้ย จะทาํใหจุ้ดสาํคญัเสียไป ตอ้งระมดัระวงัมากยิง่ข้ึนสาํหรับหนงัสือหา
ยาก  เพราะกระดาษแผน่ ๆ อยา่งท่ีเห็นวา่ง่ายนั้น หากระนาบโฟกสัไม่ไดมุ้มซา้ยบนชดั  มุมล่างขวากระเดิด 
ผลคือ ภาพไม่โฟกสั  ผลงานก็จะไม่มีคุณค่าในการถนอมและเก็บรักษาอยา่งมีคุณค่า (และไม่อาจอา้งไดว้า่
เป็นตน้แบบงานอนุรักษ)์ 

 
เลนส์ซูมแมคโคร (Macro zoom lens)  

กลอ้งดิจิทลั 35 DSLR นิยมใชเ้ลนส์ซูมกนัมากข้ึน เพราะใหค้วามสะดวกและคล่องตวั  ช่างภาพ
สามารถปรับทางยาวโฟกสัของเลนส์ ใหมี้ค่าทางยาวโฟกสัตามค่าท่ีตอ้งการ ทาํใหเ้ลือกตดัส่วนและ
ถ่ายภาพไดอ้ยา่งง่ายๆ ไม่ตอ้งเสียเวลาถอดเลนส์และเปล่ียนเลนส์  เพราะเลนส์ซูมจะมีชุดของเลนส์อยูใ่นตวั
กลอ้ง  เลนส์ซูมแมคโคร เช่น เลนส์ 28-105 มม. จะมีการถ่ายภาพแบบแมคโครเขา้มาดว้ย ทาํใหเ้ลนส์เหล่าน้ี
เป็นเลนส์อเนกประสงค ์แต่ถือวา่ไม่ใช่ แมคโครแท ้เป็นแมคโครเทียม (Psudo macrolens)  เลนส์แมค
โครเทียม มีขอ้ระวงัในการใชง้านท่ีวา่ นอกจากตวัเลนส์มกัจะใหญ่และหนกัแลว้ ในการออกแบบตวัเลนส์
หน่ึงตวัใหใ้ชง้านได ้อเนกประสงคน์ั้น ตอ้งเป็นเลนส์ซูมท่ีมีช้ินเลนส์หลายช้ิน ทาํใหต้วัเลนส์(กินแสง) 
สูญเสียแสงไปมาก  ภาพท่ีไดจึ้งมกัไม่ค่อยคมชดั สีก็อาจไม่สดใสอยา่งท่ีควรจะเป็น  เลนส์แมคโครซูม
ดงักล่าวน้ี  เป็นส่วนหน่ึงของจุดขายของผูผ้ลิตเลนส์โดยเฉพาะผูผ้ลิตเลนส์อิสระมกัจะชอบผลิตเลนส์ซูมให้

                                                 
1

 [Oberon],  Macro Photography : สรรค์สร้างภาพประทบัใจของโลกใบเลก็. (กรุงเทพฯ : โปรวชิัน่, 2552), หนา้ 11. 
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มี Mode แมคโครข้ึนมา  ซ่ึงมกัมีกาํลงัขยายอตัราส่วน 1 : 4  หมายถึง ขนาดของภาพในฟิลม์จะเป็นขนาด ¼ 
ของขนาดวตัถุท่ีถ่ายนั้น  และเม่ือสังเกตภาพขยายใกล ้ๆ เม่ือเทียบกบัเลนส์แมคโครแท ้ๆ จะพบวา่  ภาพท่ี
ไดมี้อาการขอบภาพมืดและเกิดการบิดเบ้ียวของรูปทรงข้ึน  (Weakness and distortion)  แต่ในปัจจุบนั 2009  
เลนส์ประเภทน้ีมีการปรับปรุงคุณภาพดีข้ึน  ไม่กินแสงและมีคุณภาพของภาพท่ีไดดี้ข้ึน 
 
2. แท่นก็อปป้ีภาพ (Copy stand) 
 แท่นก็อปป้ีภาพ (Copying stand)  ประกอบดว้ยเสาและแป้นสาํหรับยดึจบักลอ้งถ่ายภาพ ตวัเสายดึ
กบัแผน่กระดานเพื่อใหม้ัน่คงในการใชง้าน ตวัเสามีแป้นยดึสาํหรับติดกลอ้ง มีอุปกรณ์มือหมุนให้เล่ือนเขา้
ออกและใหเ้ล่ือนสูง – ตํ่า ตามความเหมาะสมในการใชง้านไดโ้ดยสะดวก2   แท่นก็อปป้ีบางรุ่นจะมีไฟส่อง
สวา่งติดมาดว้ยหรืออาจซ้ือเพิ่มใหเ้หมาะสมกบังาน  ควรเลือกใชแ้ท่นก็อปป้ีใหมี้ขนาดพอเหมาะกบัชนิด
ของกลอ้งและเลนส์ท่ีจะใชถ่้าย   ในกรณีของงานถ่ายหนงัสือหายากของศูนยว์ทิยทรัพยากร จุฬาฯ  หนงัสือ
หายากส่วนใหญ่มี ขนาด A5  (ประมาณ พอ็คเก็ตบุค๊)และขนาด A4   งานถ่ายภาพจึงเลือกใชแ้ท่นก็อปป้ี
ขนาดกลาง พื้นของแท่นก็อปป้ีควรเลือกชนิดสีดาํหรือเทา  ควรเป็นสีดา้น แต่ไม่ควรเลือกสีขาว เพราะการ
วดัแสงถ่ายภาพจะหลอกเคร่ืองวดัแสงใหผ้ิดพลาดได ้

                                                 
2

 ทอม เช้ือววิฒัน์, เรียนถ่ายภาพ(ด้วยตนเอง) หลกัสูตรทัว่ไป. (กรุงเทพฯ : เปิดกลอ้งส่องโลก, 2528?), หนา้ 43. 
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     แท่นก็อปป้ีภาพ 

3. ไฟส่องสวา่ง   
ในการเตรียมการเร่ืองของแสงนั้น งานถ่ายภาพได้มีการพฒันาและปรับปรุงเคร่ืองมือถ่ายภาพและ

ไฟถ่ายภาพ (ตามรายละเอียดปรากฏในหนา้ต่อไป) เพื่อให้เหมาะสมกบัโครงการจดัทาํหนงัสือ
อิเล็กทรอนิกส์คร้ังน้ี  ในการผลิตภาพดิจิทลั ภาพสีและสไลดสี์ อาจมีปัญหาเร่ืองคุณภาพงาน อนัเป็นผล
เน่ืองจากการจดัแสงท่ีไม่เหมาะสม ไม่ถูกตอ้ง   แต่เดิมภาพสี สไลดสี์นั้น นิยมถ่ายภาพโดยใชฟิ้ลม์ชนิด 
Daylight  การถ่ายภาพสีและสไลดรู์ปภาพจากหนงัสือหรือแคปชัน่  ตอ้งใชแ้สงแดดในช่วงเวลา 9.30 - 
11.00 น. ถึงจะไดสี้ดีและถูกตอ้ง ถา้ถ่ายในช่วงบ่าย ก็มกัจะออกอมสีฟ้า (blue) มากจนเกินไป นอกจากนั้น
ในวนัท่ีแดดไม่ดี, วนัฝนตก ก็ไม่สามารถถ่ายสไลดไ์ด ้แต่เม่ือมาเป็นภาพจากดิจิทลัและการถ่ายท่ีใชก้ลอ้ง
ดิจิทลั  ช่างภาพตอ้งใชก้ารปรับ WB  (White Balane) และ ก็ตอ้งเลือก light source  ใหถู้กตอ้ง 
  
ความเข้าใจในเร่ืองของทฤษฎขีองแสงและสี3 
3.1) อุณหภูมิสีของตน้กาํเนิดแสงไฟประดิษฐ ์(Artificial   Light) 

                                                 
3

 ศกัดา ศิริพนัธ์, การถ่ายภาพสี.  (กรุงเทพฯ : ด่านสุทธาการพิมพ,์ 2527), หนา้ 15. 
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 หลอดไฟประดิษฐมี์หลากหลายชนิด  หลายประเภท  แต่ละแบบก็จะใหแ้สงสวา่ง   สีและ มี
อุณหภูมิสีแตกต่างกนัตามชนิดของการผลิตเพื่อนาํไปใชง้าน  โดยรวมๆแลว้ อาจแสดงตารางเปรียบเทียบได้
ดงัน้ี 
 
ชนิดของตน้กาํเนิดแสง อุณหภูมิสีโดยประมาณ K 
เปลวเทียน 
หลอดไฟทงัสเตนท่ีใชใ้นบา้น 100วตัต ์
หลอดไฟทงัสเตนท่ีใชถ่้ายภาพในสตูดิโอ500 วตัต ์
หลอดไฟทงัสเตนท่ีใชถ่้ายภาพ  500 วตัต ์
หลอดแฟลชท่ีไส้หลอดเป็นอลูมิเนียม 
หลอดแฟลชท่ีไส้หลอดเป็นเซอร์โคเนียม 
หลอดแฟลชสีนํ้าเงิน 
หลอดไฟซีนอน 
หลอดแฟลชอิเล็กทรอนิกส์ 

2600° 
2800° 
3200° 
3400° 
3800° 
3950° 
5500° 
5400° 
5000°- 6000° 

 
3.2) หลอดไฟฟลูออเรสเซนต ์ (Fluoresent  lamps)   
 หลอดไฟชนิดน้ีเป็นหลอดท่ีใหแ้สงสวา่งมากกวา่หลอดแบบเผาไส้ ( Incandesent  lamps)  
ส้ินเปลืองพลงังานนอ้ยกวา่  ไม่ร้อน  และอายกุารใชง้านยาวนานกวา่  หลอดไฟฟลูออเรสเซนตบ์างประเภท  
จะสร้างมาใหมี้สีแสงถูกตอ้งท่ีสุด  โดยมีคุณลกัษณะของหลอดกาํกบัมา ดงัตวัอยา่งตารางแสดงค่า
เปรียบเทียบชนิดของหลอดไฟวาวแสงแต่ละประเภทท่ีให้ค่าอุณหภูมิสีเทียบเคียงแตกต่างกนัออกไป 
 
ชนิดของหลอดไฟวาวแสง อุณหภูมิสีโดยประมาณ K 
ชนิดแสงขาวขุ่น (Warm   White  Tube) 
ชนิดแสงกลางวนั (Daylight  tube) 
ชนิดโครมา 50 (Chroma  50 ของ GE) 
ชนิดแสงกลางวนั 5000° (Daylight 5000°) 
ชนิดแสงกลางวนั 5400° (Cool  Daylight  5400°) 
(ของบริษทั  ฟิลิปส์) 
 

3700° 
4800° 
5000° 
5000° 
5400° 

     
หลอดไฟฟลูออเรสเซนตห์รือหลอดไฟวาวแสง  เป็นหลอดไฟประดิษฐท่ี์น่าสนใจ  นาํมาใชใ้นการถ่ายภาพ  
เพราะ ไม่ร้อน ราคาไม่แพง  มีคุณลกัษณะท่ีน่าสนใจดงัน้ี 
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หลอดวาวแสง  ตามทฤษฎีแลว้ตอ้งถือวา่ไม่มีค่าอุณหภูมิสีท่ีแทจ้ริง  เพราะการเกิดแสงในหลอดไฟวาวแสง
นั้น เกิดจากรังสีอุลตราไวโอเลตในหลอด ตกกระทบสารเรืองแสงท่ีฉาบไวภ้ายในดา้นขา้งหลอด ซ่ึงต่างจาก
หลอดจุดไส้ธรรมดาท่ีทาํให้หลอดร้อน แลว้ไส้หลอดเปล่งความสวา่งออกไป ดงันั้นจึงถือวา่หลอดไฟวาว
แสงน้ีมีสีของแสงจริง  แต่มิไดแ้สดงระดบัของอุณหภูมิ  ความสวา่งของแสงสวา่งจากหลอดไฟวาวแสงก็ให้
แสงสวา่ง   เรียกอุณหภูมิสีของหลอดไฟวาวแสงท่ีค่าอุณหภูมิสีเทียบเคียง (correlated colour  tempereture) 
 
3.3) อุณหภูมิสีของตน้กาํเนิดแสงธรรมชาติ 
 ในการถ่ายภาพสีดว้ยฟิลม์ เราตอ้งคาํนึงถึงอุณหภูมิสีของตน้กาํเนิดแสง  ฟิลม์ท่ีนาํมาถ่ายสไลด ์
เช่น  ฟิลม์รีเวอร์แซล (Positive   Film) หรือชนิดใชแ้สงกลางวนั  (Daylight  Type)  ฟิลม์เหล่าน้ีเหมาะกบั
แสงแดดกลางวนั ซ่ึงมีอุณหภูมิสี 5,000° K  ฟิลม์จะใหสี้สมจริงเหมือนธรรมชาติ  ซ่ึงถา้อุณหภูมิสีของแสง
เปล่ียนไปตามธรรมชาติเน่ืองจากทอ้งฟ้ามีเมฆมาก  ช่วงเวลาเชา้ – บ่าย  ก็จะใหผ้ลของสีแตกต่างกนัออกไป 
ในเวลากลางวนั   แสงจากดวงอาทิตยจ์ะเป็นแหล่งแสงธรรมชาติท่ีสาํคญัท่ีสุด  แต่ควบคุมไดย้ากท่ีสุด  
เพราะจะแปรเปล่ียนตามวนัเวลา  ตาํแหน่งของดวงอาทิตยใ์นรอบวนั   อุณหภูมิสีดงักล่าวน้ีอาจจะแสดงได้
ตามตารางขา้งล่างดงัน้ี 
ตน้กาํเนิดแสงธรรมชาติ อุณหภูมิสีโดยประมาณ K 
แสงอาทิตยต์อนรุ่งอรุณ 2000° 
แสงอาทิตยต์อน 17.00 น. 4300° 
แสงอาทิตยต์อนเท่ียงวนั 5400° 
แสงจนัทร์คืนวนัเพญ็ 5400° 
แสงกลางวนัท่ีใชถ่้ายภาพสี 5500° 
แสงกลางวนัเฉล่ียของซีไออี * ชนิดซี 6500° 
แสงกลางวนัท่ีมีเมฆปกคลุมทอ้งฟ้า 7500°- 8000° 
แสงกลางวนัท่ีทอ้งฟ้ามีมีฟ้าเขม้ 10000°-20000° 

 
3.4) ทฤษฎีของแสงและสี  

 3.4.1 Correlated color Temperature, CCT.อุณหภูมิของสี (สีของแสง) 
 อุณหภูมิท่ีสัมพนัธ์กนัของแหล่งกาํเนิดแสง แสดงเป็นองศาเคลวนิ (สัญลกัษณ์ K)  และใชเ้ป็น
คาํอธิบายแหล่งกาํเนิดแสงท่ีมีอุณหภูมิสีสัมพนัธ์ท่ีมีค่าตํ่า (2700° K ถึง 3500° K) จดัอยูใ่นกลุ่มสีอุ่น เช่น สี 
Warm white, White Deluxe และ  Royal white (แสงโคมไฟส่วนใหญ่ มีอุณหภูมิสีระหวา่ง 2700° K ถึง 
3500° K) แหล่งกาํเนิดแสงท่ีเป็นฟลูออเรสเซนต ์มีอุณหภูมิสัมพนัธ์สูงข้ึนมา จดัอยูใ่นกลุ่มสีเยน็ เช่น Cool 
white, Cool white Deluxe หรือ แสงกลางวนั อุณหภูมิสีสัมพนัธ์ของแหล่งกาํเนิดสีน้ี มีส่วนช่วยอยา่งมากต่อ
การปรากฏชดัแจง้ของพื้นท่ีท่ีสวา่งอยูน่ั้นทั้งหมด 
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  3.4.2. Color Rendering Index ดชันีสี CRI 
  ดชันีสี เป็นระบบตวัเลขสากลจาก 0-100 ซ่ึงจะแสดงคุณสมบติัการสะทอ้นของสีท่ีสัมพนัธ์
กนัของแหล่งกาํเนิดแสง เม่ือเปรียบเทียบกบัแหล่งอา้งอิงมาตรฐานของค่าแสงแบบเดียวกนั ดชันีจะแสดงค่า
องศาซ่ึงสีจะปรากฎแบบ “คุน้เคย” หรือ “เป็นธรรมชาติ”  ภายใตแ้หล่งกาํเนิดแสงท่ีถูกเลือกมา โดยปกติ
หากค่า CRI ยงัสูง   สีของวตัถุภายใตแ้หล่งกาํเนิดแสงนั้นจะดีข้ึนตามลาํดบั ค่าดชันี CRI ของแหล่งกาํเนิด
แสง 2 จุด ควรนาํมาเปรียบกนัเฉพาะเม่ือทั้งสองแหล่งมีอุณหภูมิสีสัมพนัธ์ตวัเดียวกนัเท่านั้น 

 
การแก้ไขปัญหาและพฒันางานถ่ายภาพ : ไฟถ่ายภาพ 
ปัญหา : ไฟถ่ายภาพท่ีมีอยูย่งัไม่เหมาะกบัการถ่ายภาพหนงัสือหายาก เน่ืองจากหนงัสือหายากมีสีต่างจาก
หนงัสือทัว่ไป(จากความเก่า)  
 งานถ่ายภาพไดป้รับปรุงไฟถ่ายภาพ พร้อมแท่นถ่ายภาพ copy stand โดยใชห้ลกัการดงัน้ี คือ 
การใช้ไฟ Daylight น้ันต้องใช้กบัฟิล์ม Day light  สีจึงจะออกมาถูกตอ้ง โดยเฉพาะไฟนํ้าเงิน Blue Daylight  
หลอดไฟฟ้าชนิดหลอดไส้ เป็น“หลอดไฟฟ้าชนิดเปล่งแสงจากวตัถุร้อน” ภายในหลอด ไฟฟ้าไหลผา่นไส้
เป็นขดลวดบางๆท่ีมีความตา้นทานสูง  ลกัษณะของไส้หลอดจะขดเหมือนสปริง มีขนาดแตกต่างกนั ข้ึนอยู่
กบักาํลงัไฟฟ้าของหลอดไฟฟ้า  หลอดท่ีมีกาํลงัไฟฟ้าตํ่าไส้หลอดจะใหญ่ ความตา้นทานนอ้ย ส่วนหลอดท่ี
มีกาํลงัไฟฟ้าสูงไส้หลอดจะเล็กและมีความตา้นทานมาก 
 หลอดไส้มีหลกัการทาํงาน คือ เม่ือกระแสไฟฟ้าผา่นไส้หลอดท่ีทาํจากทงัสเตน ซ่ึงเป็นโลหะท่ีมีจุด
หลอมเหลวสูง จะทาํใหไ้ส้ร้อน เม่ืออุณหภูมิสูงถึง 500 องศาเซลเซียส ไส้หลอดก็จะเร่ิมเปล่งแสงพร้อมทั้ง
ปล่อยความร้อนออกมา ไส้หลอดยิง่ร้อน แสงสวา่งก็ยิง่เพิ่มข้ึนตามไปดว้ยเม่ือเทียบกบัหลอดชนิดอ่ืน แต่ก็มี
ความส้ินเปลืองเพราะเป็นหลอดประสิทธิภาพตํ่า พลงังานหมดไปกบัการแผรั่งสีความร้อน รังสีอินฟราเรด 
มีเพียง 6 เปอร์เซ็นตท่ี์ใหแ้สงสวา่ง มีอายกุารใชง้านสั้น 1,000 ชัว่โมง  จากนั้นการใหแ้สงสวา่งก็จะลดลง  
การทาํงานใชก้ารติดตั้งหลอดโดยใชแ้ท่นก็อปป้ีใหไ้ฟส่องเขา้ 45° ทั้งสองขา้ง คือ ขา้งซา้ยและขา้งขวา  ก็จะ
ไดแ้สงสวา่งสาํหรับการทาํงานถ่ายภาพ  ช้ินงานต่างๆ สามารถถ่ายสไลด ์ภาพดิจิทลั ภาพสีท่ีมีสีสันสวยงาม 
ถูกตอ้ง  แต่มีขอ้เสีย คือ ร้อนมากๆ และหลอดไฟ Daylight น้ีมีราคาแพง  จดัเป็นวสัดุส้ินเปลือง และหาก
ตอ้งถ่ายสไลดจ์าํนวนมาก จะไม่สะดวก อยา่งไรก็ตามวธีิน้ีก็ไม่ตอ้งคอยแสงแดด 
   
การทดลอง  

หลอดฟลูออเรสเซนต ์(fluorescent) /หลอดเรืองแสงหรือหลอดวาวแสง “ไส้หลอด” ทาํดว้ยโลหะ
ทงัสเตนอยูท่ี่ขั้ว  ภายในหลอดฟลูออเรสเซนตสู์บอากาศออกจนหมดแลว้ใส่ไอปรอทไว ้ ดา้นในฉาบดว้ย
สารวาวแสง ( fluorescent coating ) ซ่ึงจะใหสี้ต่างกนั หลอดฟลูออเรสเซนตเ์ป็นหลอดท่ีมีหลกัการใหแ้สง
สวา่ง โดยไม่เก่ียวขอ้งกบัการทาํใหเ้กิดความร้อน แต่ใชก้ารถ่ายเทประจุไฟฟ้า เม่ือจ่ายกระแสไฟฟ้าเขา้ไปยงั
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ขั้วหลอดทั้งสองขา้งดว้ยความต่างศกัยท่ี์สูง  จะทาํใหข้ั้วทงัเสตนปล่อยอิเล็กตรอนออกมาพร้อมกนัท่ีปลาย
ทั้งสอง ทาํใหมี้การไหลของกระแส เกิดการอาร์คระหวา่งปลายขั้วทั้งสอง  ความร้อนจากการอาร์คจะทาํให้
ปรอทเป็นไอ การเคล่ือนตวัของอิเล็กตรอนในไอปรอทมีการปล่อยรังสีอลัตร้าไวโอเลต ทาํใหส้าร
ฟอสเฟอร์ท่ีเคลือบดา้นในหลอดแกว้เรืองแสง  หลอดให้แสงสวา่งสมํ่าเสมอ 
 
 การดาํเนินการทดลองในการน้ี  งานถ่ายภาพไดท้ดลองนาํหลอดฟลูออเรสเซนต ์GTE Sylvania 
รุ่น Design 50 มีค่า CCT  5000° K, ค่า CRI = 91 ซ่ึงค่าสีของแสงท่ีไดจ้ะเป็น Daylight เท่ากบัแสงสะทอ้น
ของแดดภายนอก แต่ของงานถ่ายภาพจะคงท่ี  ท่ี 5000° K และมีค่า CRI 91 ซ่ึงค่าขนาดน้ี จะใหสี้ถูกตอ้งตาม
ความจริง จึงนาํหลอดน้ีมาใชโ้ดยตรงในการถ่ายภาพ โดยทาํเป็นโคมไฟใส่หลอด ขา้งละ 4 หลอด ทั้ง
ดา้นซา้ยและขวา ทาํใหไ้ดแ้ท่นก๊อบป้ีพร้อมโคมไฟ (ดูรูป) เป็นชุดสาํเร็จพร้อมใช ้ ทาํใหส้ามารถใหบ้ริการ
ถ่ายภาพในหอ้งปฏิบติัการถ่ายภาพของงานถ่ายภาพไดต้ลอดเวลา 
 
 

 
 
    โตะ๊ถ่ายภาพประกอบแท่นก็อปป้ีพร้อมไฟส่องสวา่ง 

 
ตวัแปรการทดสอบ  ไดท้ดสอบโดยใชฟิ้ลม์สไลดสี์ และฟิลม์สี และถ่ายภาพดิจิทลั ถ่ายไฟ Day light ถ่าย
แสงแดดเวลา 10.00 น. ในวนัท่ีมีอากาศแจ่มใส และถ่ายไฟถ่ายภาพ Design 50 โดยถ่ายแผน่ทดสอบสี The  
macbeth color checker (color Rendition Chart) 
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แผน่เทียบสี (Colorchecker) 
 

  ผลการทดสอบ  ภาพท่ีไดจ้ากฟิลม์สไลดสี์ และฟิลม์สี และภาพถ่ายดิจิทลั คุณลกัษณะของสี
ไม่แตกต่างกนั จากไดท้ดลองปฏิบติั  ปรากฎวา่ผลเป็นท่ียอมรับและพึงพอใจ สาํหรับเจา้ของงาน 
 
ผลต่อเน่ืองจากการทดลอง 

ปัจจุบนั งานถ่ายภาพไดพ้ฒันาและปรับปรุงไฟถ่ายภาพเพิม่เติม โดยนาํหลอดคอมแพคฟลูออเรส
เซนต ์(หลอดตะเกียบ) ชนิดท่ีมีบลัลาสตอ์ยูภ่ายในใชแ้ทนหลอดฟลูออเรสเซนตท์รงกระบอกยาว ท าให้มุม
ของการให้แสง/ หลบแสงสะท้อนดีขึน้  โดยคุณสมบติัท่ีสาํคญัของหลอดตะเกียบชนิดน้ี คือ ช่วยประหยดั
พลงังานไฟฟ้าและมีอายกุารใชง้านท่ียาวนานกวา่หลอดฟลูออเรสเซนต ์โคมไฟส่องลงในพื้นท่ี ใหแ้สงทัว่
ในบริเวณท่ีจาํเป็นตอ้งเปิดไฟไวน้าน  
 
แสงและลกัษณะของตาํแหน่งดวงไฟ 
 แท่นก็อปป้ีท่ีติดกลอ้งแลว้นั้น เม่ือวางหนงัสือก็พร้อมจะถ่ายไปไดที้ละหนา้ โดยอาจอาศยัแสงจาก
ธรรมชาติ คือแสงแดด โดยให้แสงเขา้ทางดา้นหนา้ ไม่มีอะไรมาบงัเวลาถ่าย  สังเกตสภาพแสงท่ีตกกระทบ
บนหนา้กระดาษวา่ เรียบเสมอกนัก็ใชไ้ด ้ แต่ถา้ไม่มีแสงแดด ก็ถ่ายไม่ได ้ หากมีแสง แต่สภาพแสงไม่ดีก็
ถ่ายไม่ได ้นอกจากนั้นระดบัความเขม้ของแสงท่ีเปล่ียนไป จะทาํใหสี้ของภาพ คือสีของหนา้กระดาษ
แตกต่างกนัไปอีกดว้ย  ในการทาํงานโครงการจดัทาํหนงัสืออิเล็กทรอนิกส์คร้ังน้ี งานถ่ายภาพไดท้ดสอบ
ออกแบบไฟโดยใช้ไฟประดิษฐ์ มาเป็นแหล่งก าเนิดแสง  เพื่อใหไ้ดส้ภาพแสงท่ีสมํ่าเสมอ อาํนวยความ
สะดวกในการปฏิบติังานไดเ้ป็นอยา่งดี  
 การถ่ายทาํควรวางแท่นก็อปป้ีภาพบนโตะ๊สูงขนาดพอเหมาะกบัตวับุคคลผูป้ฏิบติังาน จดัตาํแหน่ง
ดวงไฟใหส่้องสวา่งลงท่ีบริเวณหนงัสือบนกระดานของแท่นก็อปป้ี  ใหแ้สงสวา่งนั้นเกล่ียทัว่หนา้หนงัสือ
ใหแ้สงเขา้ทางดา้นขา้ง คือดา้นซา้ย และขวาทาํมุม 60 องศา ตาํแหน่งของแสงมีผลต่อคุณภาพของภาพมาก  
ในกรณีมุมหลอดไฟส่องแสงทาํมุม 60 องศากบัแกนกลางของกลอ้งนั้น  จะทาํใหแ้สงมีมุมท่ีห่างจากเลนส์
ของกลอ้ง  ทาํใหล้ดการสะทอ้นแสงของภาพไปยงัเลนส์นอ้ยลง ทาํใหล้ดการแฟลร์ลง  นอกจากนั้นการใช้
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เลนส์ฮูดสวมไวห้นา้เลนส์แมคโคร  ก็ช่วยป้องกนัไดร้ะดบัหน่ึงเช่นกนั  เม่ือสภาพแสงท่ีใชใ้นการถ่ายภาพมี
คุณภาพดี มุมในถ่ายภาพทาํใหก้ารส่องสวา่งถูกตอ้ง แสงสวา่งเกล่ียบนผวิกระดาษดี  ผลลพัธ์ คือ  ความ
เปรียบต่างของสีขาวและดาํ(Contrast) ดีข้ึนและทาํใหภ้าพมีความอ่ิมตวัของสี คือ Saturation สมบูรณ์ดี 
 อยา่งไรก็ดี การวางตาํแหน่งไฟนั้นข้ึนอยูก่บัลกัษณะของไฟ  ไฟสมยัใหม่เป็นแบบหลอดตะเกียบ 
ไฟเป็นแผงส่ีเหล่ียมมีแผน่กระจายแสง  ลดการ Hot spot ลงท่ีแสงบนวตัถุได ้   อน่ึงการจดัไฟท่ีตาํแหน่ง   
45 องศา ถึง 60 องศา จากแกนกลางก็เป็นมุมท่ีใชไ้ด ้    ในการถ่ายก็อปป้ีภาพ ตอ้งหมัน่สังเกตและค่อย ๆ  
ถ่ายทาํ เก็บรายละเอียดผลงานและทดสอบตวัแปรต่างๆ จนกวา่จะไดเ้ป็นท่ีพึงพอใจ 
 
4. สายลัน่ไกชตัเตอร์ 

การใชส้ายลัน่ชตัเตอร์ซ่ึงเป็นอุปกรณ์สาํหรับกดชตัเตอร์นั้น  เม่ือติดตั้งกลอ้งร่วมกนักบัขาตั้งแลว้ 
สายลัน่ชตัเตอร์จะช่วยลดความสั่นสะเทือนในการกดชตัเตอร์  ทาํใหภ้าพไม่สั่นไหว  และยงัใชล้็อคชตัเตอร์
เม่ือเวลาตอ้งการบนัทึกภาพเป็นเวลานานๆดว้ย   สายลัน่ไกชตัเตอร์ราคาไม่แพง  ช่วยใหก้ดชตัเตอร์ได้
นุ่มนวลและไม่ทาํใหก้ลอ้งสั่นไหว 

 
5. ขาตั้งกลอ้ง 

ขาตั้งกลอ้งเป็นอุปกรณ์สาํหรับการตั้งกลอ้งเพื่อใหก้ลอ้งน่ิงมากกวา่การถือกลอ้งดว้ยมือ  ขาตั้ง
กลอ้งมีความจาํเป็นมากเม่ือตอ้งถ่ายภาพนานๆ   ควรเลือกใชข้าตั้งสาํหรับตั้งกลอ้งชนิดท่ีแขง็แรง  เน่ืองจาก
บางคร้ัง ช่างภาพก็ตอ้งถ่ายภาพในท่ีๆ มีแสงนอ้ยๆ  การจะใชเ้ลนส์ขนาดใหญ่หรือมีนํ้าหนกัมากๆ ทาํไดไ้ม่
สะดวก และหากไม่ใช ้ภาพกจ็ะสั่นไหว  ไม่คมชดั  ดงันั้นในท่ีมีแสงนอ้ยและไม่สามารถถือกลอ้งดว้ยมือ 
หรือเม่ือตอ้งใชค้วามเร็วชตัเตอร์ตํ่าๆ เพื่อใหแ้สงพอดี  จึงตอ้งอาศยัขาตั้งกลอ้งช่วย  ขาตั้งกลอ้งท่ีไม่แขง็แรง
ทาํใหไ้ดภ้าพท่ีถ่ายพร่ามวั ไม่คมชดัไดเ้ช่นกนั4  ในกรณีท่ีไม่แน่ใจวา่ขาตั้งจะมัน่คงดีหรือไม่    ให้เตรียมใช้
ถุงทรายหนกัๆ ต่างนํ้าหนกัแขวนถ่วง เป็นการลดความสั่นสะเทือนลง   ส่วนการใชส้ายลัน่ชตัเตอร์ซ่ึงเป็น
อุปกรณ์สาํหรับกดชตัเตอร์  เม่ือติดตั้งกลอ้งร่วมกนักบัขาตั้งแลว้ สายลัน่ไกชตัเตอร์จะช่วยลดความ
สั่นสะเทือนในการกดชตัเตอร์ไดอี้กทางหน่ึงดว้ย  เพิ่มความมัน่ใจวา่ภาพจะไม่สั่นไหว  

บางคร้ังพบวา่หนา้กระดาษมีใบแทรกเป็นแผนท่ีขนาดใหญ่ ช่างภาพไม่อาจถ่ายภาพไดโ้ดยใชแ้ท่น
ถ่ายภาพปกติ ช่างภาพตอ้งดดัแปลงโดยการนาํขาตั้งกลอ้งมาใชย้ดึกลอ้ง เอกสารท่ีจะถ่ายตอ้งแผอ่อกขึงให้
ตึงจดัมุมกลอ้งและระดบัให้ภาพอยูใ่นกรอบจึงจะถ่ายทาํได ้

 
6 . กระดาษสีดาํดา้น  

                                                 
4

 ประสิทธ์ิ จนัเสรีกร, คู่มอืใช้กล้องดจิติอล SLR Canon EOS 400D/300D. (กรุงเทพฯ : นิตยสาร Shutter Photography,  
           2549), หนา้ 99. 



13 

 

 กระดาษสาํหรับรองหนา้กระดาษเพื่อถ่ายภาพ ควรเลือกใชก้ระดาษโปสเตอร์สีดาํดา้นสนิท ใหต้ดั
ไวห้ลายๆ  ขนาด  โดยใหมี้ขนาดใหญ่กวา่หนา้หนงัสือ 
 
7. กระจกดา้น (Matte mirror) 
กระจกดา้น  เป็น กระจกพื้นผวิเรียบและไม่สะทอ้นแสง ควรจดัหาไวแ้ละตดัไวเ้พื่อทบัหนา้กระดาษใหเ้ลือก
ตดัไวห้ลายๆ  ขนาด  เช่น ขนาด 5" x  7"  ขนาด 8"  x 10" และ 10" x 12"  เจียรมุมดว้ยหินลบัมีดหรือกระดาษ
ทรายขดัเหล็ก จากนั้นใชก้ระดาษกาวแรกซีนหุม้ขอบกระจก 
 

ขั้นตอนการถ่ายภาพ 
 1. ยดึจบักลอ้งกบัอุปกรณ์  ยึดขนักบัสกรู ยดึกลอ้งใหแ้น่น ดูระดบัของกลอ้งวา่ขนานกบัพื้นแท่นก็
อปป้ีหรือไม่ ถา้ยงัไม่ขนาน ตอ้งเปล่ียนใหไ้ดร้ะนาบขนาน อาจใชท่ี้วดัระดบันํ้าช่วย 
  2. วางหนงัสือท่ีจะถ่ายลงบนพื้นแท่นถ่ายภาพ 
  3. มองในววิไฟน์เดอร์กลอ้ง หรือ จอ LCD ของกลอ้งวา่ไดร้ะนาบ  ภาพมีอาการบิดเบือนเอียงซา้ย
หรือไม่ 
  4. วดัแสงและลงมือถ่ายทาํไดป้กติเหมือนการถ่ายภาพทัว่ไป  
 

Photo tip 
Mode Live View โหมดน้ีจะช่วยใหใ้นขณะทาํการถ่ายภาพ  ช่างภาพจะมองในช่องมองภาพเพื่อดู

รูปท่ีจะถ่ายหนงัสือหายากแต่ละหนา้  เม่ือจดัเรียงหนา้ตามลาํดบัท่ีจะถ่ายแลว้นั้น  กลอ้ง 35 DSLR บางรุ่น 
ช่างภาพสามารถใชจ้อ LCD ดา้นหลงัและปัจจุบนั (2009) นิยมทาํจอภาพขนาด LCD ใหญ่  ช่วยในการ
มองเห็นภาพท่ีจะถ่ายไดดี้ข้ึน  ช่างภาพสามารถเลือกองคป์ระกอบ  จดัสัดส่วนภาพ ดู ความเหมาะสมไดดี้
ยิง่ข้ึน  เพราะมองเห็นไดช้ดัเจนมากกวา่ในช่องมองภาพ  การถ่ายหนงัสือหายากน้ี  ตอ้งพิจารณาทั้งความ
คมชดัและความสวา่งของหนา้กระดาษวา่ มีคุณภาพของสีและการตดักนัของตวัหนงัสือและพื้นกระดาษวา่
เป็นอยา่งไร 

 
การเลือกโหมด Program 
การเลือกโหมด Program ของกลอ้งดิจิทลั DSLR ท่ีเหมาะสมจะทาํใหก้ารปฎิบติังานง่ายข้ึนและ

สะดวกรวดเร็วมาก mode AV หรือโหมด Arerture priority ช่างภาพใชเ้พื่อเลือกควบคุมความชดัลึกของภาพ
ในโหมดน้ี เม่ือตั้งค่ารูรับแสงท่ี f/22 จะเป็นการตั้งระยะความชดัลึกของเลนส์ถ่ายภาพมากท่ีสุด กลไกของ
กลอ้งจะเลือกสปีดชตัเตอร์ท่ีสัมพนัธ์กนัให ้ถึงสปีดชตัเตอร์จะตํ่าก็ไม่เป็นไร เพราะตวักลอ้งยดึอยูก่บัแท่น
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ก๊อบป้ีอยา่งแน่นหนาแลว้ ช่างภาพจึงอาจใชส้ปีดชตัเตอร์ตํ่าๆ ได ้โดยไม่ตอ้งกลวัภาพจะสั่นไหว (แต่ก็ควร
ใชส้ายลัน่ไกชตัเตอร์ดว้ย) 

 
การตั้งค่า ISO  
ISO  คือค่าความไวแสงช่างภาพเลือก การตั้งค่า ISO สาํหรับสภาพแสงเม่ือสภาพแสงนอ้ย จะเลือก

ตํ่า ค่า ISO สูงๆเช่นท่ี800,1600 แต่ถา้สภาพแสงมากจะตั้ง ISO ตํ่าเช่นท่ี100,200ท่ีค่าISO ตํ่าจะเกิด Noise ใน
ภาพนอ้ย และในทางกลบักนัถา้ ISO ยิง่สูงมากๆ ก็จะมี Noise เกิดข้ึนมาก 

ในการจดัทาํหนงัสือหายาก ช่างภาพจดัสภาพแสงใหเ้หมาะสม คือ มีปริมาณแสงเกล่ืยลงในหนา้
หนงัสือพอดีแลว้ จึงเลือกใช ้ISO ประมาณ 200 เพื่อหลีกเล่ียง Noise ท่ีจะเกิดข้ึน 
การวดัแสง  (Metering) 
 กลอ้ง  DSLR สมยัปัจจุบนัมีการวดัแสงท่ีแม่นยาํและเท่ียงตรงมากในการวดัแสงนั้น จะมีรูปแบบ
การวดัแสงท่ีแตกต่างกนัออกไป แต่ผลลพัธ์ก็คือ ช่างภาพตอ้งการวดัแสงให้พอดี ถา้วดัแสงผิดพลาดผลท่ี
เกิดข้ึนคือ ภาพท่ีบางไป ภาพออกมาสวา่งมาก เรียกวา่ ภาพโอเวอร์  (OVER)  ในทางตรงกนัขา้มถา้วดัแสง
แล้วภาพท่ีออกมาดาํมืดเกินไป เรียกว่า ภาพอนัเดอร์ (UNDER)  ภาพใน 2 ลกัษณะน้ีเป็นภาพท่ีขาด
รายละเอียดและไม่มีคุณภาพ หมายรวมถึงวา่ การถ่ายภาพนั้นไม่มีคุณภาพดว้ย 
 ช่างภาพตอ้งพยายามวดัแสงใหภ้าพท่ีถ่ายไดอ้อกมาพอดี ตรงน้ีตอ้งใชท้กัษะและความสังเกต จดจาํ
อยูบ่่อยคร้ัง แต่กฎพื้นฐานอยา่งแรกคือ ตอ้งเขา้ใจระบบการวดัแสงของกลอ้งก่อน 
 
การวดัแสงของกลอ้งนั้น มี 3 แบบ หลกัๆ คือ 
 1. การวดัแสงแบบเฉพาะจุด (Spot Metering)  กลอ้งจะวดัแสงเฉพาะจุดเท่านั้น  แบบวิธีวดัแสง
แบบน้ี จะใช้เฉพาะภาพวตัถุท่ีตอ้งการเนน้ ตรงจุดนั้นๆ ก็จะพอดี ซ่ึงโดยปกติ การวดัแสงเฉพาะจุด จะวดั
ประมาณ 3-4% ของพื้นท่ี ทาํให้ตรงจุดพอดี แต่บริเวณฐานรอบนอกจุดนั้นๆ ก็จะมืด หรือ สวา่ง แลว้แต่
สภาพแสงและบรรยากาศ 
 2. การวดัแสงแบบเฉล่ียหนกักลาง(Center weighted Metering)  การวดัแสงแบบน้ีเหมาะสําหรับ
การถ่ายภาพกรณี วตัถุในภาพอยู่ตรงกลาง (มีมวลนํ้ าหนักภาพเน้นตรงกลาง)  ของภาพ กล้องจะวดัแสง
เฉพาะวตัถุในภาพอยูต่รงกลาง และวดัแสง รอบนอกดว้ยเล็กนอ้ยทาํใหภ้าพท่ีถ่ายไดมี้สภาพแสงพอดี เพราะ
การวดัแสงแบบเนน้เฉพาะวตัถุอยูต่รงกลาง 
 3. การวดัแสงแบบเฉล่ียทั้งภาพ (Average Metering ) การวดัแสงแบบน้ี กลอ้งจะทาํการวดัแสง
เท่ากนัทุกพื้นท่ีในภาพ แลว้กลอ้งจะนาํมามวนในหาค่าเฉล่ียให้กบัภาพทั้งหมด วิธีการวดัแบบน้ีดีตรงมนั
สะทอ้นความเป็นจริง เช่น ถา้พื้นท่ีส่วนใหญ่มืด ภาพท่ีไดก้็จะออกมามืด แต่ถา้ภาพส่วนใหญ่เห็นภาพสวา่ง 
ภาพท่ีไดก้็จะออกมาสวา่ง ทั้งท่ีในความเป็นจริงช่างภาพ ตอ้งการใหภ้าพออกมาพอดี  
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 ในการปฏิบติังานถ่ายภาพ หนงัสือหายาก การเลือกระบบวดัแสงของกลอ้งให้เลือกระบบวดัแสง
แบบเฉล่ียทั้งภาพ เพราะวา่เป็นการวดัหนา้กระดาษทั้งหนา้ และหนา้กระดาษมีสีขาวหม่นจนถึงสีนํ้ าตาล ตดั
กบัหมึกจากการพิมพต์วัตะก่ึงสีดาํ จากนั้นให้ทดลอง สังเกตผลลพัธ์ท่ีได ้จากนั้นให้ชดเชยแสงของกลอ้ง
โดยใช ้โหมด conpensate( 1+........0........- )1ทดลองถ่ายทาํดูสังเกตและจดบนัทึก ทดลองจนไดค้่าท่ีพอดี 
สาํหรับ การถ่ายภาพหนา้กระดาษ 
  
เทคนิคเพือ่ความคมชัดของการถ่ายภาพหนังสือหายาก 

ในการถ่ายภาพหนงัสือหายากนั้น ช่างภาพจะพลิกหนา้กระดาษไปทีละหนา้ มองในววิไฟนเดอร์
ของกลอ้งและดูภาพหนา้หนงัสือท่ีปรากฏในจอภาพวา่ หนา้เอียงซา้ยขวา ตอ้งหนุนรองดว้ยวสัดุใดใหไ้ด้
ระดบั ถึงจะถ่ายได ้ หลกัส าคัญคือ ท าให้หน้าแผ่นกระดาษน้ันเรียบทีสุ่ด จึงจะลงมือถ่ายทาํหนา้นั้นได ้
บางคร้ังตอ้งใชว้ธีิการกดอยา่งระมดัระวงั หรือใชว้สัดุมีนํ้าหนกัทบั เม่ือแกไ้ขปัญหาความเรียบไดแ้ลว้ ก็
พร้อมถ่ายได ้ การใชก้ระจกทบัหนา้กระดาษขณะถ่ายภาพ ก็เป็นอีกวธีิหน่ึงท่ีช่วยให้หนา้กระดาษเรียบ     
ไม่โก่งหรือโคง้งอ   กระจกนั้นเลือกใชก้ระจกท่ีเรียกกนัวา่  กระจกดา้น (Matte mirror) เพราะเป็นกระจกท่ี
นอกจากเป็นพื้นผวิเรียบแลว้ยงัไม่สะทอ้นแสง ไม่ก่อใหเ้กิดจุด hot spot บนพื้นผวิกระจก  แต่บางคร้ังเน้ือ
กระดาษการพิมพห์นา้หนงัสือนั้นมีปัญหา เช่น ใชห้มึกดาํและกระดาษหนงัสือบาง ทาํใหห้มึกซึมข้ึนมาเป็น
เงาสีเทาดาํลางๆ ใหแ้กปั้ญหาดว้ยการนาํกระดาษสีดาํมารองดา้นใต ้จะช่วยแกปั้ญหาน้ีได ้
 ในส่วนท่ีเป็นเลนส์ถ่ายภาพนั้น หากช่างภาพเลือกใชเ้ลนส์แมคโคร ควรเลือกเปิดกลอ้ง คือรูรับแสง
ใหเ้หมาะสม ไม่ควรเลือกเปิดรูรับแสงค่าเลขเอฟสูงๆ เช่น 22 เพื่อเนน้ความคมชดัลึกเกินไป เพราะ ท่ีค่าเอฟ
ขนาดน้ี ช่องเปิดรูรับแสงของเลนส์นั้นมีขนาดเล็กเกินไป จะทาํใหเ้กิดการเล้ียวเบนของแสง  แสงท่ีเล้ียวเบน
น้ีจะทาํใหคุ้ณภาพของภาพท่ีไดต้ ํ่า มีผลทาํใหคุ้ณภาพของภาพท่ีไดไ้ม่คมชดั 

 
ขั้นตอนการปรับแต่งภาพให้สวยงามก่อนน าส่ง 

ในกระบวนการถ่ายภาพดิจิทลันั้นเม่ือถ่ายภาพแลว้ช่างภาพตอ้งใชโ้ปรแกรมตกแต่งภาพ Photoshop  
CS แต่งภาพทางเทคนิคเพื่อใหส้วยงามมากกวา่ท่ีถ่ายมาได ้ เช่นโดยใชค้าํสั่งปรับแต่งสีและแสงเงา อยูใ่น 
เมนู Image >ADJUSTMENT เช่น  การปรับดว้ยคาํสั่งอตัโนมติั (Auto  Levels)การปรับความคมชดั  
(Sharpness)   ,การปรับค่าความสวา่งและความมืดของภาพ (over and under  exposure) 
โดยพิจารณาเคร่ืองมือ/ค่าการทาํงาน ต่าง  ลกัษณะ  ซ่ึงช่างภาพทุกคนตอ้งสามารถปฏิบติัได ้ดงัน้ี  
 
1. การปรับค่าโทนสี การ ปรับแต่งสีและแสงเงา Levels 
เน่ืองจากช่วงโทนสีของกลอ้งแคบ ภาพท่ีไดจึ้งมีสีความเขม้นอ้ยกวา่ฟิลม์สไลด ์ช่างภาพตอ้งปรับค่าโทนสี 
(level) เพื่อใหไ้ดภ้าพท่ีมีความเขม้ข้ึน หรือภาษาถ่ายภาพคือ “มีเน้ือนัน่เอง”   
การปรับค่า Levels  มี 2 วธีิดว้ยกนั คือ 
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          1) ปรับดว้ยคาํสั่งอตัโนมติั (Auto  Levels)  
สามารถใหโ้ปรแกรมปรับค่าอตัโนมติัได ้โดยคลิกเมนู  Image > Adjustments > Auto  Levels   
โปรแกรมจะประมวลผลปรับระดบัความอ่ิมตวัสีใหโ้ดยอตัโนมติั 
1.เปิดไฟลภ์าพ 
2.เลือกคาํสั่ง  Auto  Levels 
3.ภาพจะอ่ิมตวัสีมากข้ึน 
          2.) การปรับแต่งดว้ยคาํสั่ง (Manual  Levels)  
ในบางคร้ังการปรับแต่งภาพอตัโนมติัจากคาํสั่ง Auto  Levels  อาจไดภ้าพไม่สวย (เน่ืองจากลกัษณะของ
ภาพ)  เราสามารถปรับไดโ้ดยคลิกเมนู  Image > Adjustments>  Levels….  เม่ือปรากฎหนา้ต่าง  Levels  ให้
เล่ือนเมาส์ปุ่มสามเหล่ียม  ปรับค่าพร้อมสังเกตผลลพัธ์  (เพิ่ม – ลดค่าช่อง  Input  Levels)  
ค่านอ้ยลงจะทาํใหภ้าพเขม้และตดักนัมาก  ค่ามากข้ึนทาํใหภ้าพสวา่งและตดักนันอ้ย 
1.เปิดไฟลภ์าพ 
2.เลือกคาํสั่ง  Levels 
3.ปรับค่าสังเกตภาพและท่ีตอ้งการ 
4.ภาพจะอ่ิมตวัสีมากข้ึน 
 
2. การปรับค่าความสวา่งและความมืดของภาพ (over and under  exposure)โดยใชค้าํสั่งปรับค่าความสวา่ง
และความมืดของภาพ อยูใ่น เมนู IMAGE >ADJUSTMENT>CURVES 
วธีิการปรับภาพถ่ายท่ีมืดใหส้วา่งข้ึน  (Under  exposure) 

 ภาพมืด ท่ีเรียกวา่ภาพ “Under exposure”  นั้น มีวธีิการแกไ้ข คือ เพิ่มความสวา่งใหก้บัภาพ   
ปัจจุบนัไฟลภ์าพดิจิทลัท่ีถ่ายมา Under สามารถแกไ้ขได ้โดยแกไ้ขความสวา่งเฉพาะส่วนท่ีมืดในภาพดว้ย
คาํสั่งในโปรแกรม Photoshop  วธีิการเพิ่มความสวา่งภาพดว้ยคาํสั่ง  Curves  ทาํไดด้งัน้ี 

 1. สร้าง  Selection จุดท่ีตอ้งเพิ่มความสวา่ง 
 2. ใชค้าํสั่ง  Curves…เลือกคาํสั่งปรับสีแบบเส้นโคง้  ใหค้ลิกบนเส้น   
 3. ลากเมาส์เพิ่มความสวา่งใหก้บัทั้งภาพ  Channel : RGB    
 

วธีิการการปรับภาพถ่ายท่ีสวา่งเกินไปใหเ้ขน้ข้ึน  (Over  exposure) 
 ภาพท่ีมีความสวา่งมากเกิน  เรียกวา่ “Over  exposure”  วธีิแกไ้ขโดยปกติคือ ลดแสงให้นอ้ยลง
กวา่เดิม ไฟลภ์าพดิจิทลัสามารถแกไ้ขใน  Photoshop  ดว้ยขั้นตอนดงัน้ี 
  1. คลิกปุ่มเมาส์ เลือกคาํสั่ง Curves… 
  2. คลิกบนเส้นและเล่ือนลงเพื่อใหร้ะดบัสีอ่ิมข้ึน 
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  3. สังเกตภาพผลลพัธ์ท่ีได ้
 
3. ค่าการปรับความคมชดั (Sharpness)  โดยใชค้าํสั่งปรับปรับความคมชดั อยูใ่น เมนู FILTERr>SHARPEN 
แมว้า่คุณภาพของ CCD  และ CMOS จะดีเพียงใด ก็ยงัไม่สามารถใหคุ้ณภาพของไฟลภ์าพคมชดัเท่าฟิลม์ได ้  
การใช ้Mode  Sharpening  ใน Photoshop  CS  จะทาํใหไ้ฟลภ์าพดิจิทลัมีความคมชดัมากข้ึน ซ่ึงสามารถทาํ
ไดด้งัน้ี 

1)  ใส่ฟิลเตอร์ให้ภาพชดั 
Copy  เลเยอร์เพิ่มข้ึน 1  เลเยอร์ ใส่ฟิลเตอร์  Unsharp  Mask  ผลทาํใหภ้าพชดัข้ึน สามารถกาํหนดค่าความ
คมชดัใหเ้พิ่มข้ึนตามตอ้งการ  ดูผลลพัธ์จากช่อง Preview  ของฟิลเตอร์ 

1. Copy  เลเยอร์ 
2. ใส่ฟิลเตอร์  Unsharp  Mask… 
3. ปรับค่าใหภ้าพชดัข้ึน 

  Amoun t  : 500 (เพิ่มความชดั) 
  Radius      : 3.0 (ค่ารัศมีการเพิ่มความชดั) 
  Threshold : 5   (เกล่ียระดบัความคมชดั 5 ระดบั) 
2)  เปล่ียนโหมดใหภ้าพเป็นธรรมชาติ 

การใส่ฟิลเตอร์เพิ่มความคมชดัมากข้ึน  ทาํใหภ้าพเกิด Grain หรือจุด  pixels  ภาพจะดูแตก ไม่เป็นธรรมชาติ
ตอ้งเปล่ียน  Blending  Mode   ใหภ้าพเกล่ียจุดเหล่าน้ีอยา่งนุ่มนวล  หลงัจากแกไ้ขเสร็จก็สามารถรวมเลเยอร์
เป็นภาพปกติ 

 1. เลือกโหมด  Luminosity 
 2. คลิกเมนู  Layer > Flatten  Image 
 

โดยใชค้าํสั่งการตดัส่วนภาพ อยูใ่น เมนู Image> Canvas  Size   
 
4. ค่าการตดัส่วนภาพ (Cropping)  โดยใชค้าํสั่งการตดัส่วนภาพ อยูใ่น เมนู Image> Canvas  Size   
การตดัส่วนภาพในโปรแกรมตกแต่งภาพ  Photoshop  CS  ก็เหมือนกบัการตดัส่วนภาพ (Cropping)ในหอ้ง
มืดเวลาอดัขยายรูปขาวดาํหรือรูปสีนัน่เอง  ภาพท่ีไดจ้ากการตดัส่วน (cropping) จะมีองคป์ระกอบของภาพ
ท่ีสมบูรณ์ข้ึน สีและสัดส่วนของจุดสนใจในภาพดีข้ึน 
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วธีิการครอปภาพเพื่อยอ่ – ขยายภาพ สามารถทาํไดด้งัน้ี 
 
การปรับขนาดภาพใหเ้ปล่ียนไปสามารถทาํไดโ้ดยชุดโปรแกรมสาํเร็จรูป ดว้ยคาํสั่ง  Canvas  Size  

( Image > Canvas  Size…)  โปรแกรมจะ  Crop  เหลือบริเวณส่วนท่ีตอ้งการในภาพ  หรือขยายภาพเพิ่มข้ึน
จากเดิม ตามขั้นตอนดา้นล่าง 

 1.ภาพถ่าย 
 2.ขนาดเบ้ืองตน้ 
 3.กรอกค่าลดลง 
 4.เลือกทิศทางการ  Crop 
 5.ปุ่ม Proceed 
 6.ภาพถูก Crop เล็กลง 
 

 
วธีิการครอปภาพเพื่อเลือกเฉพาะส่วนท่ีตอ้งการ สามารถทาํไดด้งัน้ี 

การใชโ้ปรแกรมสาํเร็จรูป crop ภาพเฉพาะส่วนท่ีตอ้งการนั้นมกัจะใชใ้นกรณีท่ีไม่สามารถ
กาํหนดค่าดว้ยคาํสั่ง  Canvas  Size   ไดอ้ยา่งสะดวก  โดยใชว้ธีิการดงัน้ี  

 1.ลากเมาส์เลือกเลือกบริเวณ  Crop   
 2.หมุนกรอบใหพ้อดีเพื่อเลือกเฉพาะบริเวณท่ีตอ้งการ 
 3.กดปุ่ม < Enter>  
 4.ภาพถูก Crop ใหเ้ล็ก 

 
   เม่ือปรับแต่งภาพดิจิทลัเรียบร้อยแลว้ ช่างภาพตอ้งเก็บไฟลภ์าพนั้นลง CD/DVD ตามท่ีกาํหนด 
ภาพดิจิทลัแต่ละแผน่ แต่ละซอง/กล่องท่ีใส่หรือกล่องกาํกบั ตอ้งลงรายละเอียดของหนงัสือใหช้ดัเจน เช่น 
ช่ือหนงัสือ ลงวนั เดือน ปี จากนั้น จดักลุ่ม CD/DVD ทั้งหมด  เพื่อนาํมาเขา้ระบบการจดัเก็บโดยมีการแบ่ง
หมวดหมู่ใหช้ดัเจน เพื่อสะดวกต่อการคน้คืนเม่ือตอ้งการ   
 
 
ขั้นตอนการนาํส่งไฟลภ์าพและตน้ฉบบัคืน 
เม่ือช่างภาพเตรียมงานภาพ ตกแต่งภาพ และนาํใส่กล่อง/ซอง พร้อมระบุรายละเอียดตามกาํหนดแลว้ จะนาํ
ไฟลภ์าพพร้อมตน้ฉบบัหนงัสือส่งคืนบรรณารักษเ์จา้ของงาน ซ่ึงเม่ือบรรณารักษรั์บงานพร้อมตรวจสอบ
ความถูกตอ้งครบถว้นขอ้งขอ้มูล รวมทั้งตรวจหนงัสือตน้ฉบบัวา่ไม่มีความเสียหายแลว้ บรรณารักษจ์ะเป็น
ผูน้าํข้ึนสู่กระบวนการจดัแสดงบนเวบไซต ์หนา้ e- Text ต่อไป 
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อภปิรายผลโครงการ 
 

องค์ความรู้ทีไ่ด้จากการจัดท าหนังสืออเิล็กทรอนิกส์ฯ (Lessons learned) 
 ความพยายามในการแปลงส่ือสารนิเทศเป็นส่ือดิจิทลัไดรั้บการพฒันามากข้ึนในงานส่ือโสตทศัน์
หลายประเภท แต่การเร่ิมทดลองดาํเนินการกบัส่ือส่ิงพิมพน์ั้น  ศูนยว์ทิยทรัพยากรไดต้ดัสินใจเร่ิมโครงการ
กบังานหนงัสือหายากก่อน เพราะนอกจากจะเป็นการแปลงส่ือเพื่องานบริการแลว้ ยงัไดป้ระโยชน์ในแง่งาน
อนุรักษด์ว้ย  เม่ือเร่ิมดาํเนินงานกบัหนงัสือหายากไดมี้การคิดหาวธีิการหลากหลายเพื่อการทาํงานท่ีมี
ประสิทธิภาพประสิทธิผลสูงสุด  เร่ิมท่ีการเลือกวธีิการแปลงหนา้หนงัสือ  ช่วงแรกคิดวา่จะเลือกใช้
โปรแกรม OCR  (Optical Characters Recognition)แต่พบวา่ เกิดปัญหาเทคนิคดา้นฟอนตอ์กัษร เน่ืองจาก
ตวัอกัษรของหนงัสือหายากเป็นตวัพิมพต์ะกัว่ยคุโบราณ โปรแกรมปัจจุบนัไม่สามารถเลือกหาฟอนตอ์กัษร
อ่านได ้  ทางเลือกต่อมาคือ การใชโ้ปรแกรมสแกนหนา้หนงัสือ   ในกรณีของหนงัสือใหม่ถือเป็นวธีิท่ีดีและ
รวดเร็ว แต่หากเป็นหนงัสือหายากท่ีเป็นหนงัสือเก่า หนา้กระดาษบางและกรอบ การสแกนหนา้หนงัสือ
เท่ากบัเป็นการทาํลายหนงัสือโดยตรง  ทางเลือกท่ีดีท่ีสุดขณะนั้นจึงไดแ้ก่ การใชก้ลอ้งดิจิทลัถ่ายภาพทีละ
หนา้โดยใชช่้างภาพผูช้าํนาญ การนาํมาเรียงร้อยเป็นเล่มตามรูปแบบทางกายภาพ 
  

งานถ่ายภาพจึงไดรั้บมอบหมายใหด้าํเนินการโครงการทดลองน้ี ( pilot project)  (ตามท่ีไดก้ล่าวมา
ในตอนตน้)  เม่ือส้ินสุดการทาํโครงการฯ งานถ่ายภาพใหไ้ดรั้บขอ้ความรู้อนัอาจประมวลเป็นองคค์วามรู้
เพื่อประโยชน์ในการปฏิบติังานและการจดัทาํหนงัสืออิเล็กทรอนิกส์ในอนาคตได ้ดงัน้ี 

 
1. เพิ่มพนูความรู้และทกัษะของผูป้ฏิบติังานในการถ่ายภาพลกัษณะพิเศษ ตวัอยา่งความรู้ท่ีไดจ้าก

การศึกษาเทคนิคของเคร่ืองมือและวธีิการในการถ่ายภาพหนงัสือหายากคร้ังน้ี ไดแ้ก่ 
1) ความรู้เร่ืองการจดัแสงสาํหรับหนงัสือหายากท่ีมีสีต่างจากหนงัสือปกติ (ปรากฏ

รายละเอียดใน การทดลองเร่ืองการจดัไฟ) 
2) ช่างภาพตอ้งมีและ/หรือเพิ่มพนูความรู้เก่ียวกบัการถ่ายภาพและเคร่ืองมือและอุปกรณ์

ถ่ายภาพท่ีเก่ียวขอ้งเป็นพิเศษ เช่น เลนส์มาโคร และ แท่นก็อปป้ี  
3) เทคนิคการจบัภาพใหใ้กล้ๆ  หมายถึง การนาํกลอ้งและเลนฺส์เขา้ใกลใ้หไ้ดต้วัหนงัสือ

เตม็หนา้พอดี จะเห็นตวัหนงัสือชดัเจน ทาํใหต้วัหนงัสือมีความคมชดัเจนมากข้ึน 
4) สังเกตพื้นหลงัวา่มีหมึกพิมพเ์ลอะข้ึนมาไหม  หากมีตอ้งใชก้ระดาษดาํสอดขา้งใต ้
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5) สังเกตลกัษณะท่ีแตกต่างในภาพ เช่น เม่ือเปิดถ่ายทีละหนา้ ตอ้งสังเกตส่ิงผดิปกติก่อน
ถ่ายทุกคร้ัง เช่น อาจมีเศษวสัดุแปลกปลอมคัน่อยูใ่นหนา้กระดาษ ตอ้งนาํส่ิงผดิปกติ
นั้นออก หรือพบหนา้(พิมพ)์ผดิ 

6) วธีิการปฏิบติังานถ่ายภาพดว้ยกลอ้งดิจิตอล  เป็นวธีิหน่ึงท่ีใชไ้ดดี้ในงานหนงัสือหา
ยากอิเล็กทรอนิกส์  แต่ก็ไม่ใช่งานง่าย ช่างภาพตอ้งไดรั้บการฝึกฝนมากพอสมควรใน
ประเด็นดงัน้ี 

 ความรู้ความเขา้ใจเร่ืองกลอ้งอยา่งดี  ตอ้งรู้จกัเลือกเลนส์/  เลือกกลอ้ง 
 ช่างภาพตอ้งเขา้ใจวธีิการทาํงานถ่ายภาพเพื่อใหไ้ดคุ้ณภาพดี 
 ช่างภาพตอ้งเป็นนกัอนุรักษห์นงัสือดว้ย  เช่น  ในขณะถ่ายภาพนั้นควรตอ้ง

ใส่ถุงมือขณะจบัตอ้งหนงัสือและเม่ือทาํการถ่ายทาํไปทีละหนา้นั้น  หากมี
หนา้กระดาษเสียหายตอ้งเพิ่มความระมดัระวงัเป็นพิเศษ  ตอ้งเก็บช้ินส่วน 
ใส่ซองกระดาษ เขียนเลขหมายหนา้ชาํรุดหนา้ซอง  และใส่กล่องรวมไวเ้พื่อ
ความสมบูรณ์ของตวัเล่ม เม่ือส่งคืนแก่บรรณารักษ ์

  
2.  สร้างความรู้ความเขา้ใจในคุณค่าของหนงัสือหายาก ซ่ึงเป็นมรดกทางภูมิปัญญาของประเทศ 

1) หนงัสือหายากส่วนใหญ่เป็นหนงัสือท่ีมีอายมุาก ตีพิมพข์อ้ความรู้ในอดีต ซ่ึงเป็นการ
ส่งผา่นมรดกทางวฒันธรรม และภูมิปัญญาจากอดีตมาสู่ปัจจุบนั  การถ่ายทอดจากส่ือ
ส่ิงพิมพซ่ึ์งไม่อาจเขา้ถึงไดง่้าย มาเป็นส่ือดิจิตอล ซ่ึงสามารถเขา้ถึงและเผยแพร่สู่
สาธารณะไดง่้าย นอกจากจะทาํใหส้ารสนเทศนั้นคงอยูอ่ยา่งดีแลว้ ยงัสามารถนาํเสนอ
สู่คนรุ่นใหม่ผา่นเทคโนโลยท่ีีทนัสมยัไดด้ว้ย 

2) เม่ือหนงัสือหายากอิเล็กทรอนิกส์ไดรั้บการเผยแพร่สู่สาธารณะอยา่งกวา้งขวางแลว้นั้น 
เป็นท่ีเช่ือไดว้า่ หนงัสือหายากอีกจาํนวนมากท่ียงัไม่ไดรั้บความสนใจ หรือยงัไม่เป็นท่ี
รู้จกั จะมีการสนใจคน้ควา้ศึกษามากข้ึน  

 
3. เกิดความเช่ือมโยงระหวา่งนวตักรรมใหม่ๆ ทางดา้นเทคโนโลยสีารสนเทศและเทคโนโลยี

ทางการศึกษากบังานหอ้งสมุด 
1) งานหอ้งสมุดแบบดั้งเดิมเนน้การรวบรวมสารสนเทศประเภทต่างๆ ไวใ้นท่ีเดียวกนั 

เพื่อความสะดวกในการคน้ควา้ของผูใ้ชบ้ริการ เม่ือเทคโนโลยใีหม่ๆ พฒันาข้ึน ส่ือ
อิเล็กทรอนิกส์และดิจิตอลสามารถแกไ้ขปัญหาในอดีตได ้ทาํใหง้านง่ายข้ึน การ
ผสมผสานเช่ือมโยงความรู้และเทคนิคจากต่างสาขาก่อให้เกิดประโยชน์สูงสุดในงาน 
ดงัเช่น การนาํความรู้ในงานถ่ายภาพซ่ึงเป็นเทคโนโลยทีางการศึกษาประสานความรู้
ทางเทคโนโลยสีารสนเทศ เกิดการแปลงส่ือดิจิทลัสาํหรับงานหนงัสือหายากคร้ังน้ี 
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2) การเช่ือมโยงและประสานระหวา่งสาขาวชิาไม่เพียงปรากฏในการปฏิบติังาน แต่ยงั
ตอ้งพฒันาในระดบัผูป้ฏิบติังานดว้ย บรรณารักษแ์ละนกัวชิาการโสตทศันศึกษาไม่
เพียงตอ้งรับต่องานกนั หากตอ้งทาํความเขา้ใจในงานของกนัและกนั การเรียนรู้และ
ทาํความเขา้ใจในงานท่ีแตกต่างกนั ก่อใหเ้กิดภูมิรู้ในตวัตนของกนัอีกส่วนหน่ึงดว้ย 

 
4. เป็นตน้แบบของการพฒันาหนงัสือหายากอิเล็กทรอนิกส์ของศูนยว์ทิยทรัพยากร 

1) เม่ือศูนยว์ทิยทรัพยากรเร่ิมโครงการทดลองหนงัสือหายากอิเล็กทรอนิกส์นั้น (2546) 
ยงัไม่มีหน่วยงานบริการสารสนเทศแห่งใดจดัทาํหนงัสืออิเล็กทรอนิกส์ดว้ยตนเอง
มากนกั บางแห่งท่ีดาํเนินการ ก็เป็นการสแกนหนา้หนงัสือทั้งส้ิน ศูนยว์ทิยทรัพยากร
จึงเป็นหน่วยงานบริการแห่งแรกท่ีริเร่ิมจดัทาํหนงัสืออิเล็กทรอนิกส์ดว้ยการถ่ายภาพ 
การเป็นผูริ้เร่ิมนั้น มีทั้งขอ้ดีและขอ้ดอ้ย ขอ้ดีคือ การแสดงถึงศกัยภาพในการเป็นผูน้าํ
ดา้นการพฒันาบริการสารสนเทศและการสร้างนวตักรรมงานเทคนิคและบริการ 
ขอ้ดอ้ย คือ การตอ้งเรียนรู้ท่ีจะแกไ้ขปัญหาใหไ้ดท้นัการณ์ เพื่อใหง้านไม่ไดรั้บ
ผลกระทบจากขอ้ผดิพลาด งานถ่ายภาพไม่มีโอกาสลองผิด/ถูก  ทุกขั้นตอน
กระบวนงานตอ้งวางแผนอยา่งรอบคอบ หากไม่มัน่ใจ ตอ้งทดสอบนอกรอบ เพราะ
เม่ือลงมือปฏิบติัจริง หนงัสือหายากเป็นทรัพยากรสารสนเทศท่ีไม่อาจหาทดแทนได ้
ตอ้งไม่ใหเ้กิดความเสียหายกบัตวัเล่มโดยเด็ดขาด อยา่งไรก็ตามขอ้ดอ้ยน้ี สาํหรับ
ผูป้ฏิบติังานแลว้ ถือเป็นโอกาสในการเรียนรู้ท่ีดียิง่ เพราะหากไม่พบปัญหาแลว้ ก็จะ
ไม่เกิดความรู้ อนัเป็นเทคนิคท่ีเกิดจากการพฒันางาน 

2) เม่ือโครงการฯน้ีส้ินสุดลงและมีการนาํหนงัสือหายากอิเล็กทรอนิกส์ข้ึนใหบ้ริการและ
เผยแพร่บน website ของศูนยว์ทิยทรัพยากรแลว้  หน่วยงานต่างๆ จาํนวนมากสนใจ
ติดต่อขอเขา้ชมและศึกษาการจดัทาํหนงัสือหายากอิเล็กทรอนิกส์  ศูนยว์ทิยทรัพยากร
ไดช่ื้อวา่ เป็นตน้แบบการจดัทาํหนงัสืออิเล็กทรอนิกส์ สาํหรับหนงัสือเก่าท่ีมีคุณค่า 
และเป็น ผูน้าํในการพฒันางานหนงัสืออิเล็กทรอนิกส์ทัว่ไป 

3 )    การอนุรักษห์นงัสือเก่าในปัจจุบนัน้ี ในแง่ของการปฏิบติังาน ผูป้ฏิบติังานมีการ   
                                  ยอมรับระดบัหน่ึงแลว้วา่ การใชก้ลอ้งดิจิทลัท่ีมีความเหมาะสม และเป็นเคร่ืองมือ     

ประกอบการถ่ายภาพท่ีดี  สามารถถ่ายภาพหนงัสือเก่าได ้และไดไ้ฟลภ์าพเป็นหนา้ 
หนงัสือ 1 หนา้หนงัสือ ต่อ 1 ไฟลภ์าพ เม่ือนาํไฟลภ์าพหลายๆ ไฟลม์าต่อกนัก็คือ เล่ม 
หนงัสือ  โดยนยัน้ี ในทางปฏิบติัก็สามารถทาํหนา้หนงัสืออิเล็กโทรนิกส์ได ้และหลาย     
หน่วยงานก็ไดเ้ร่ิมใชก้ลอ้งดิจิทลัปฏิบติังานในทาํนองน้ีแลว้ 
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ข้อเสนอแนะเพือ่การด าเนินการขั้นต่อไปของโครงการ 
 

โครงการต่อไป : หนงัสือหายากอิเล็กทรอนิกส์ประเภทเอกสารตน้ฉบบัตวัเขียนสมุดไทย 
เม่ือโครงการนาํร่อง หนงัสือหายากอิเล็กทรอนิกส์ไดรั้บผลสาํเร็จเป็นท่ีน่าพอใจระดบัหน่ึงแลว้ ผูเ้สนอ
ผลงานมีแนวคิดจะพฒันาจากพื้นฐานความรู้น้ีสู่การจดัทาํหนงัสือหายากอิเล็กทรอนิกส์ประเภทเอกสาร
ตน้ฉบบัตวัเขียนหรือสมุดไทยขาวและสมุดไทยดาํ (สมุดไทยใบลาน) ต่อไป เน่ืองจากศูนยว์ทิยทรัพยากร
เป็นหน่ึงในแหล่งทรัพยากรสารสนเทศประเภทเอกสารตน้ฉบบัตวัเขียนท่ีดีท่ีสุดแหล่งหน่ึงของประเทศ 
นอกเหนือจากท่ีจดัเก็บและใหบ้ริการท่ีหอสมุดแห่งชาติ  แนวคิดท่ีจะใหง้านโครงการหนงัสือหายาก
อิเล็กทรอนิกส์ประเภทเอกสารตน้ฉบบัตวัเขียนเป็นอีกหน่ึงในนวตักรรมเทคโนโลยเีพื่องานบริการ
ทรัพยากรสารสนเทศ เพื่อวตัถุประสงคใ์นการอนุรักษม์รดกทางวรรณกรรมและคงคุณค่างานบริการเพื่อ
การศึกษาคน้ควา้นั้น  มีตน้แบบแนวคิดในการศึกษา (Model Profile) จากโครงการ Codex   
( http://www.codexsinaiticus.org/ ) ซ่ึงเป็นงานอนุรักษต์น้ฉบบัไบเบิล ท่ีเขียนดว้ยลายมือท่ีเก่าแก่ท่ีสุดใน
โลก เขียนเป็นภาษากรีก มีอายกุวา่ 1600 ปี คน้พบ ณ วหิารเซนต ์แคทเทอรีน เมา้ทไ์ซนาย โดยช้ินส่วนต่างๆ 
ของเอกสารตน้ฉบบัตวัเขียนของไบเบิลน้ีไดก้ระจดักระจายอยูใ่นความครอบครองขององคก์รรัฐและเอกชน
ต่างๆ กนั ถึง 4 แห่ง ไดแ้ก่ หอสมุดแห่งชาติองักฤษ  หอสมุดมหาวทิยาลยัไลป์ซิก  หอสมุดแห่งชาติรัสเซียท่ี
เซนตปี์เตอร์สเบิร์ก และ วหิารเซนต ์แคทเทอรีน  ในปี 2005  องคก์รทั้งส่ีทาํความร่วมมือในการอนุรักษ ์
จดัการถ่ายภาพ  ถ่ายโอนขอ้ความและเผยแพร่ขอ้มูลจากเอกสารตน้ฉบบัตวัเขียนดงักล่าว ผา่นโครงงานวิจยั
พฒันาหลายรูปแบบ  จนบงัเกิดผลงานเป็นท่ีประจกัษ ์

เม่ือผูเ้สนอผลงานตดัสินใจนาํแนวคิดจากงานน้ีพฒันาเป็นโครงการต่อเน่ือง ตอ้งมีการประเมิน
ความเป็นไปไดข้องโครงการฯ  ดว้ยการวิเคราะห์ขอ้มูลพื้นฐาน และการศึกษาขอ้มูลเพิ่มเติมดา้นอุปกรณ์ 
เคร่ืองมือ เทคโนโลยแีละวธีิการ เน่ืองจากเอกสารตน้ฉบบัตวัเขียนสมุดไทย ทั้งสมุดไทยขาวและสมุดไทย
ดาํมีลกัษณะทางกายภาพท่ีแตกต่างจากหนงัสือหายากท่ีเคยดาํเนินงานมาก่อน ตอ้งพิจารณาเคร่ืองมือท่ีจะ
เหมาะสม  ศึกษาเทคนิควธีิท่ีเหมาะสม เพราะทั้งตวัแปรและปัจจยัเปล่ียนไป รวมทั้งตอ้งศึกษาศกัยภาพของ
เคร่ืองมือ หากไม่พร้อม อาจตอ้งเตรียมแผนของบประมาณเพื่อจดัซ้ือกลอ้งดิจิทลัและเลนส์ถ่ายภาพต่อไป 

(ดูรายละเอียดในบทท่ี 3  ผลการทดลอง) 
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บทที ่2   

  ผลงานการถ่ายภาพ  
Pilot Project การจดัทาํหนงัสืออิเล็กทรอนิกส์ในโครงการหนงัสือหายากออนไลน์ : E- Text    

                
 ผลงานการถ่ายภาพหนงัสือหายากท่ีใหบ้ริการในหอ้งหนงัสือหายากของหอสมุดกลาง รวม 28  เล่ม 
(จาํนวน 2990 หนา้)น้ี ผูส้นใจศึกษาขอ้มูลเพิ่มเติมเก่ียวกบัหนงัสือหายากของหอสมุดกลาง สามารถเขา้ดูได้
ท่ี  http://www.car.chula.ac.th/web/form/resources/ หรือสามารถติดต่อใชบ้ริการ
เล่มจริงไดท่ี้หอ้งหนงัสือหายาก หอสมุดกลาง ศูนยว์ทิยทรัพยากรชั้น 6 
 

เร่ิมตน้โครงการฯและการดาํเนินงาน 
หนังสือหายากจดัเป็นทรัพยากรสารนิเทศท่ีมีค่าในเชิงประวติัศาสตร์ขององค์กร  ส่วนใหญ่เป็น

หนงัสือท่ีมีอายมุาก สภาพหนงัสือไม่พร้อมให้บริการชั้นเปิด  ดงันั้นหน่วยงานบริการสารสนเทศส่วนใหญ่ท่ี
มีหนงัสือหายากลกัษณะน้ี จึงจดัการบริการแบบชั้นปิดและเนน้ท่ีการอนุรักษ/์รักษาหรือคงสภาพหนงัสือหา
ยากเหล่านั้น  

เม่ือกระบวนการทางอิเล็กทรอนิกส์เข้ามามีบทบาทในงานห้องสมุดมากข้ึน หน่วยงานบริการ
สารสนเทศหลายแห่งเร่ิมใชก้ารแปลงทรัพยากรสารสนเทศให้เป็นส่ือดิจิทลั( digitization) เพื่อการ
ให้บริการหนังสือหายาก และเพื่อการอนุรักษ์  หอสมุดกลางและศูนย์โสตทศันศึกษากลาง ศูนย์วิทย
ทรัพยากร โดยงานถ่ายภาพไดเ้ร่ิมโครงการนาํร่องในการอนุรักษห์นงัสือเก่าหรือหนงัสือหายากท่ีจดัเก็บท่ี
หอสมุดกลาง โดยการใช้กลอ้งถ่ายภาพดิจิทลัถ่ายภาพหนงัสือหายากเหล่านั้นเพื่อการคงสภาพตวัเล่มและ
เพื่อให้ผูใ้ช้บริการสามารถใช้สารสนเทศในรูปไฟล์ดิจิทลัแทนได้  เหตุผลท่ีเลือกการถ่ายภาพดว้ยกล้อง
ดิจิทลัแทนการใชเ้คร่ืองสแกนภาพ (flatbed scanner) เน่ืองจากหนงัสือหายากส่วนใหญ่ของศูนยฯ์
เป็นหนงัสือเก่าท่ีมีคุณค่า สภาพรูปเล่มไม่สามารถใชก้ารสแกนภาพได ้เพราะจะทาํให้หนงัสือชาํรุดเสียหาย
ยิ่งข้ึน  ในการถ่ายภาพหนงัสือเก่าหรือหนงัสือหายากเหล่าน้ี ตอ้งใชค้วามพิถีพิถนั ค่อยพลิกทีละหน้า จดั
ต้นฉบบัเล่มหนังสือให้อยู่ในตาํแหน่งท่ีจะถ่ายได้ภาพท่ีคมชัดท่ีสุดเท่าท่ีจะเป็นไปได้ และให้มีความ
สมํ่าเสมอเท่ากนัทุกหน้า ทุกบทและทุกตวัอกัษร ลกัษณะการจดัถ่ายเช่นน้ีสอดคลอ้งกบังานท่ีปฏิบติัและ
รับผดิชอบอยูข่องงานถ่ายงานในการถ่ายภาพเพื่อทาํส่ือการสอน ภาพตน้ฉบบั วสัดุหรือส่ิงของ  
 งานถ่ายภาพเป็นผูรั้บผิดชอบโดยตรงในกระบวนการทางเทคนิคของโครงการฯ มีหน้าท่ีในการ
ประสานงานและจดัถ่ายภาพ  การดาํเนินงานเป็นโครงการทดลอง(pilot project)  ดาํเนินการถ่ายภาพ
ดิจิทลัหนงัสือหายาก จาํนวน 28 เล่ม และรายงานกิจการของจุฬาลงกรณ์มหาวิทยาลยั ปี 2540 และ 2541 (2 
เล่ม) จากนั้นไดน้าํไฟล์ภาพทั้งหมดข้ึนเวปไซตข์องศูนยว์ิทยทรัพยากร เป็นบริการหนงัสือหายากออนไลน์  
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รายละเอียดการเขา้ใช้งานหนงัสือหายากและรายละเอียดทางบรรณานุกรมของผลงานเหล่าน้ีปรากฏตาม
เอกสารในหนา้ต่อไป  

 

การเข้าใช้งานหนังสือหายากและรายละเอยีดทางบรรณานุกรม 

ของผลงานภาพหนังสืออเิลก็ทรอนิกส์ในโครงการ หนังสือหายากออนไลน์ : E Text 

 

             ผูส้นใจศึกษาคน้ควา้หนงัสือหายากของหอสมุดกลาง ศูนยว์ทิยทรัพยากร สามารถเขา้ใชบ้ริการไดท่ี้
เวบ็ไซทข์องศูนยว์ทิยทรัพยากร  http://www.car.chula.ac.th  หนา้ของการใหบ้ริการคน้ควา้
หนา้แรก  ให ้คลิกเลือก  ทรัพยากร จะปรากฏหนา้รายการทรัพยากรทั้งหมด  ใหค้ลิกเลือก  หนังสือหายาก
อเิลก็ทรอนิกส์     จะปรากฏหนา้  รูปหนา้ปกหนงัสือหายากและรายละเอียดทางบรรณานุกรมของหนงัสือ
หายากทั้งหมด     หากสนใจศึกษาเพิ่มเติมหนงัสือหายาก เล่มใด ใหค้ลิกเลือกท่ีหนงัสือหายาก เล่มนั้นได้
โดยตรง  โฮมเพจจะปรากฏหนา้หนงัสือและผูใ้ชส้ามารถดูไดต้ามลาํดบัหนา้หรืออาจยอ้นดูหนา้ท่ีผา่นไปได้
ตามตอ้งการ                                                                                                              
  

ในท่ีน้ีไดน้าํเสนอตวัอย่างจากหน้า  http://161.200.145.33/rarebook-ft/ ซ่ึงเป็น
หนา้รายละเอียดทางบรรณานุกรมของหนงัสือหายากเหล่าน้ีตามเอกสารในหนา้ต่อไป 

http://www.car.chula.ac.th/
http://161.200.145.33/rarebook-ft/
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บทที ่3 

ผลงานการทดลอง 
 

 ในบทท่ี 1 ขอ้เสนอแนะในการดาํเนินงานขั้นต่อไป ไดก้ล่าวถึงการทดลองถ่ายทาํหนงัสือหายาก
ประเภทต้นฉบบัตวัเขียนสมุดไทยขาวสมุดไทยดาํ ซ่ึงเป็นรูปแบบหนังสือหายากอีกประเภท หน่ึงท่ีมี
ให้บริการ เอกสารประเภทน้ีมีความแตกต่างในรูปลกัษณ์จากหนังสือหายากท่ีได้ดาํเนินการในโครงการ 
Pilot project  ดงัไดน้าํเสนอแลว้  ผูเ้สนอผลงานจึงไดท้ดลองถ่ายทาํหนงัสือหายากอิเล็กทรอนิกส์ประเภท
สมุดไทยขาว สมุดไทยดาํ ดว้ยการถ่ายภาพดิจิทลั และนาํเสนอผลงานการทดลองตามปรากฏ ณ ท่ีน้ี  
 
 สําหรับแนวคิดเร่ืองการอนุรักษ์ผลงานเอกสารโบราณดว้ยการถ่ายภาพดิจิทลันั้น ระหว่างผูเ้สนอ
ผลงานศึกษาคน้ควา้ขอ้มูลเพื่อทาํงานน้ี ไดพ้บเร่ืองราวท่ีน่าจะเป็นประโยชน์และเป็นเคร่ืองยืนยนัว่าแนว
ทางการอนุรักษเ์อกสารดว้ยภาพดิจิทลันั้น มีผูส้นใจและดาํเนินการเป็นผลสาํเร็จในระดบัสากลมาแลว้ จึงขอ
นาํเสนอรายละเอียดตน้แบบแนวคิดในการศึกษา (Model Profile) จากโครงการ Codex   
( http://www.codexsinaiticus.org/ ) ซ่ึงเป็นงานอนุรักษต์น้ฉบบัไบเบิล ท่ีเขียนดว้ยลายมือท่ีเก่าแก่ท่ีสุดใน
โลก  ซ่ึงผูเ้สนอผลงานประมวลจากเวบ็ไซต ์ โครงการ Codex  ( http://www.codexsinaiticus.org/ ) ตาม
ปรากฎในภาคผนวกทา้ยเร่ือง
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 อภิปรายผลจาการทดลอง 
 ผลจากการทดลองถ่ายภาพหนงัสือหายากอิเล็กทรอนิกส์ประเภทสมุดไทยขาว สมุดไทยดาํ ผู ้
      ทดลองสรุปขอ้ความรู้ไดด้งัน้ี 

1. เอกสารประเภทน้ี (สมุดไทยขาว สมุดไทยดาํ) มีความยุง่ยากในการเตรียมการถ่ายภาพมากกวา่ 
เอกสารแบบเดิม (เอกสารกระดาษ) ตอ้งพิถีพิถนัในการจดัวางตาํแหน่งหนงัสือบนแท่นถ่ายภาพใหเ้รียบ
เสมอกนัในทุกหนา้ หนงัสือมีลกัษณะเป็นหนา้พบัและพบัทบซอ้นกนัเป็นชั้นๆ ตอ้งถ่ายทีละหนา้ โดย
หนา้หนงัสือท่ีวางนั้นแต่ละหนา้ตอ้งไดแ้นวระดบั  ภาพตวัหนงัสือท่ีไดจึ้งจะคมชดั 

2. สมุดไทยขาว สมุดไทยดาํมีลกัษณะสีตามช่ือ(สมุดสมุดไทยดาํ) ซ่ึงเขียนดว้ยตวัหนงัสือสีขาว  
พบวา่ลกัษณะทางกายภาพ ปรากฏร่องรอยของคราบฝุ่ น เน่ืองจากเป็นหนงัสือเก่าเก็บจึงตอ้งทาํความ
สะอาดดว้ยแปรงปัดฝุ่ นในชั้นหน่ึงก่อนจึงจะถ่ายภาพได ้

3. ตวัหนงัสือสีขาวบนพื้นกระดาษสีดาํท่ีดาํไม่สนิทเพราะความเก่าตามกาลเวลา ทาํใหสี้ดาํของ 
กระดาษซีดจาง รวมทั้งสีขาวท่ีใชเ้ขียนดว้ย  การถ่ายภาพจึงตอ้งพิจารณาหามุมของไฟท่ีเกล่ียแสงให้
เรียบเนียนท่ีสุด ไม่ใชแ้สงท่ีแขง็จนเกินไป ตอ้งปรับมุมของดวงไฟ ตอ้งสังเกตดูตาํแหน่งท่ีมุมไฟส่อง
แลว้ ตวัหนงัสือชดัเจนท่ีสุด 

4. ในการถ่ายภาพนั้นการเลือกเปิดค่ารับแสงเป็นเร่ืองสาํคญั กรณีวตัถุสีขาวสีดาํจะหลอกการวดั 
แสงภายในเคร่ืองวดัแสงของกลอ้ง ช่างภาพตอ้งใชป้ระสบการณ์ตรวจสอบและประเมินใหแ้น่ใจวา่จะ
เลือกค่าวดัแสงท่ีค่าใดจึงจะเหมาะสม 

5. ในการทดลองถ่ายทาํสมุดไทยขาว สมุดไทยดาํ ไดใ้ชว้ธีิการใหม่ คือ การวางระบบ 
คอมพิวเตอร์ และกลอ้งถ่ายภาพดิจิทลัใหเ้ช่ือมต่อกนัโดยใชส้าย USB Connect และลงโปรแกรมของ
กลอ้งดิจิทลัใหก้ลอ้งและคอมพิวเตอร์รู้จกักนั เม่ือถ่ายภาพหนงัสือ ผลท่ีไดคื้อภาพจะไปปรากฏบน
จอมอนิเตอร์ทนัทีทาํใหส้ะดวก ในการปฏิบติังาน สามารถตรวจเช็คความชดัเจนของภาพตวัหนงัสือใน
แต่ละหนา้ ตรวจความถูกตอ้งของระนาบไดเ้ป็นอยา่งดี 

6. ผลของภาพท่ีได ้มีความคมชดัและคุณภาพเท่าท่ีกลอ้งจะใหไ้ด ้คือ กลอ้ง Nikon D 100 
ใหคุ้ณภาพจากการตั้งค่าของกลอ้งท่ี File : L (F)  หมายถึง File Large และ( F) คือ Fine หมายถึงความ
ละเอียด (Resolution) ไดท่ี้ 3008 x2000 pixel  ภาพท่ีไดน้าํมาปรับแต่งภาพ (การทาํรีทชัในคอมพิวเตอร์) 
โดยใชโ้ปรแกรมตกแต่งภาพ  Photoshop การปรับแต่งโดยโปรแกรมดงักล่าว จะทาํการปรับแต่งดว้ย
การครอป Crop การเพิ่มสี หรือลดคอนทราสต ์การเพิ่มหรือลดความมืดหรือความสวา่งของภาพจนได้
ผลลพัธ์เป็นท่ีพอใจ เม่ือนาํไฟลภ์าพมาต่อกนัดว้ยโปรแกรมสร้างหนงัสืออิเล็กทรอนิกส์ (เช่น flip 
album )จะไดห้นงัสืออิเล็กทรอนิกส์หน่ึงเล่ม
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ภาคผนวก 
 
 

ต้นแบบการสร้างข้อมูลอเิลก็ทรอนิกส์ของคมัภร์ีโบราณ (Bible) 
ด้วยการถ่ายภาพ  

The Codex Sinaiticus Project 
http://codexsinaiticus.org 

 
 
 
 
 
 
 
 
 
 
 
 

http://codexsinaiticus.org/
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Advanced search   

Contact | Copyright  

 

 Home 

 About Codex Sinaiticus 

 About the Project 

 See The Manuscript 

 Go to:  

 

Codex Sinaiticus  

Codex Sinaiticus is one of the most important books in the world. Handwritten well 
over 1600 years ago, the manuscript contains the Christian Bible in Greek, including 
the oldest complete copy of the New Testament. Its heavily corrected text is of 
outstanding importance for the history of the Bible and the manuscript – the oldest 
substantial book to survive Antiquity – is of supreme importance for the history of 
the book. [Find out more about Codex Sinaiticus.]  

The Codex Sinaiticus Project  

http://codexsinaiticus.org2011.retrieved/
http://www.codexsinaiticus.org/en/search.aspx
http://www.codexsinaiticus.org/en/contact.aspx
http://www.codexsinaiticus.org/en/copyright.aspx
http://www.codexsinaiticus.org/en/
http://www.codexsinaiticus.org/en/codex/
http://www.codexsinaiticus.org/en/project/
http://www.codexsinaiticus.org/en/manuscript.aspx
http://www.codexsinaiticus.org/en/codex/default.aspx
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The Codex Sinaiticus Project is an international collaboration to reunite the entire 
manuscript in digital form and make it accessible to a global audience for the first 
time. Drawing on the expertise of leading scholars, conservators and curators, the 
Project gives everyone the opportunity to connect directly with this famous 
manuscript. [Find out more about the Codex Sinaiticus Project.]  

The Codex Sinaiticus Website  

This is the first release of the Codex Sinaiticus Project website. The fully developed 
website is online since July 2009. [Find out more about its current contents.]  

Partner institutions  

The British Library   

National Library of Russia   

St. Catherines Monastery   

Leipzig University Library   

RSSSupported by       
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http://www.codexsinaiticus.org/en/project/webcontents.aspx
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http://www.sinaimonastery.com/
http://www.ub.uni-leipzig.de/
http://www.codexsinaiticus.org/handler/newsRss.ashx
http://www.codexsinaiticus.org/en/search.aspx
http://www.codexsinaiticus.org/en/contact.aspx
http://www.codexsinaiticus.org/en/copyright.aspx
http://www.codexsinaiticus.org/en/
http://www.codexsinaiticus.org/en/codex/
http://www.codexsinaiticus.org/en/project/
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Detail of scar tissue on Quire 78, folio 6 recto.  

Download the full image. 

News 

Participants 

Conservation 

Digital photography 

Transcription 

Website development 

Website presentation 

Contents of the current release 

The Codex Sinaiticus Project 

The Codex Sinaiticus Project has five principal activities:  

 historical research 

 conservation 

 digitisation 

 transcription 

 dissemination 

Historical research 

In order to clarify the circumstances under which Codex Sinaiticus came to be 
dispersed between the four institutions holding parts of the manuscript today, the 
project has undertaken new archival research to identify and study all relevant 
archival documents. The documents identified through this research are being used 
as the basis for a new account of the modern history of Codex Sinaiticus, to be 
agreed by all four partner institutions. The agreed account will be published on this 
website and in the project's printed publications. It will accompanied by transcripts 
or digital surrogates of the key archival documents wherever the permission of the 
owners can be secured. [More…] 

 

http://www.codexsinaiticus.org/en/img/ParchmentScarQ78f6r_BL237_full.jpg
http://www.codexsinaiticus.org/en/project/news.aspx
http://www.codexsinaiticus.org/en/project/participants.aspx
http://www.codexsinaiticus.org/en/project/conservation.aspx
http://www.codexsinaiticus.org/en/project/digitisation.aspx
http://www.codexsinaiticus.org/en/project/transcription.aspx
http://www.codexsinaiticus.org/en/project/webdevelopment.aspx
http://www.codexsinaiticus.org/en/project/webdevelopment.aspx
http://www.codexsinaiticus.org/en/project/webcontents.aspx
http://www.codexsinaiticus.org/en/project/history.aspx
http://www.codexsinaiticus.org/en/project/conservation.aspx
http://www.codexsinaiticus.org/en/project/digitisation.aspx
http://www.codexsinaiticus.org/en/project/transcription.aspx
http://www.codexsinaiticus.org/en/project/edition.aspx
http://www.codexsinaiticus.org/en/project/history.aspx
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Conservation 

The conservation strategy for the Codex Sinaiticus Project was set out by its 
Conservation Working Party. An initial assessment of the manuscript's leaves in all 
four locations investigated how much work would be required to stabilise them 
before digitisation and to preserve them for the future. A detailed assessment has 
been carried out in London, Leipzig and St Petersburg and is underway in St 
Catherine's Monastery. [More…] 

Digitisation 

Digitial photography of the geographically distributed leaves of Codex Sinaiticus is 
central to the Project's virtual reunification of the manuscript. Careful imaging of the 
original leaves provides a life-like view of the pages, thus allowing, for the first time, 
worldwide access to the manuscript. Images of every leaf were taken under evenly 
distributed ('standard') lighting for the main view of the manuscript. Images of every 
leaf have also been taken under raking light (i.e. lighting only from an angle) to 
emphasise the physical characteristics of the manuscript. [More…] 

Transcription 

A major research project which is led by the Institute for Textual Scholarship and 
Electronic Editing (ITSEE) at the University of Birmingham and funded by the UK's 
Arts and Humanities Research Council, has transcribed the texts of Codex Sinaiticus. 
The result is a uniquely detailed digital transcription of a Biblical codex. [More…] 

Dissemination 

The project has identified a range of products that will build upon the full scholarly 
reappraisal of the Codex and its texts and will also help to bring alive this iconic 
manuscript for everyone. The website is the main medium for making Codex 
Sinaiticus accessible. Other project outputs include a print facsimile, a conference, 
an exhibition and a popular book. [More…] 
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 Home 

 About Codex Sinaiticus 

 About the Project 

 See The Manuscript 

 Go to:  

 
Lawrence Pordes, Juan Garcés and Ulrich Johannes Schneider (from left to right) in 
front of a digitisation cradle designed by Manfred Mayer at The British Library. (© 
Charlie Gray)  

Download the full image. 

News 

Participants 

Conservation 

Digital photography 

Transcription 

Website development 

Website presentation 

Contents of the current release 

Digitisation 

One of the core undertakings of the project was to capture each page of Codex 
Sinaiticus as a high-quality digital image. Each image offers a substitute for the real 
manuscript leaf. Careful imaging of Codex Sinaiticus therefore provides a life-like 
view of the pages and allows, for the first time, worldwide access to the manuscript. 

The digital photography of Codex Sinaiticus had to establish the best practice, taking 
into account that 

1. the leaves could not travel and had to be photographed at four different venues with 

different equipment; 

2. the writing on the leaves had to be readable on the digital images; 

3. the natural appearance of the parchment and ink had to be faithfully reproduced. 

Technical standards 

http://www.codexsinaiticus.org/en/
http://www.codexsinaiticus.org/en/codex/
http://www.codexsinaiticus.org/en/project/
http://www.codexsinaiticus.org/en/manuscript.aspx
http://www.codexsinaiticus.org/en/img/csistyle_full.jpg
http://www.codexsinaiticus.org/en/project/news.aspx
http://www.codexsinaiticus.org/en/project/participants.aspx
http://www.codexsinaiticus.org/en/project/conservation.aspx
http://www.codexsinaiticus.org/en/project/digitisation.aspx
http://www.codexsinaiticus.org/en/project/transcription.aspx
http://www.codexsinaiticus.org/en/project/webdevelopment.aspx
http://www.codexsinaiticus.org/en/project/webdevelopment.aspx
http://www.codexsinaiticus.org/en/project/webcontents.aspx
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To make sure that the images produced were consistent, common standards and 
imaging practices were established across all venues by the Technical Standards 
Working Party. The recommendations included equipment (cameras, camera 
software, lighting, lenses, etc.) and processes (setup, colour profiling, etc.). 

Lighting 

When choosing the best lighting conditions for digitising Codex Sinaiticus, two 
aspects had to be carefully balanced. The writing on the leaves had to be readable 
on the digital images, to allow researchers to read and analyse it. At the same time, 
the natural appearance of the parchment and ink had to be faithfully reproduced, to 
allow the appreciation of the physical traits of Codex Sinaiticus. 

Different angles and levels of intensity were tested for the lighting, as the same set-
up had to be used for every page. Since each page reflected the light at different 
angles, owing to the natural undulation of the parchment, a compromise had to be 
found to minimise this effect. Best results were achieved when the pages were lit at 
an angle of 45 degrees on low intensity without any backlighting. 

The parchment leaves of Codex Sinaiticus feature many marks on its surface - 
pricking holes, ruling indentations, as well as many other natural details - which are 
not easily visible with the 45 degree lighting directed from both sides of the page. 
The decision was therefore made to digitise each page twice, the second time with a 
light source at a low angle from a top corner. These are the 'raking light' images 
which optimise the view of the physical features of the parchment. 

Background 

The leaves of Codex Sinaiticus are so thin that the text from the other side of the 
page can show through when photographed. An appropriate background had to be 
used to lessen the show-through and at the same time to keep as true as possible 
to the colour of the parchment. 

Tests showed that white background paper allowed a relatively faithful 
representation of the parchment colour. The text, however, was often very hard to 
read because of the show-through from the text on the other side of the leaf. Black 
background paper, on the other hand, reduced the show-through considerably in 
tests and made the text more readable. The page, however, appeared too dark and 
the colours were not represented faithfully. 

http://www.codexsinaiticus.org/en/project/participants.aspx#tswp
http://www.codexsinaiticus.org/en/project/participants.aspx#tswp
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Test image of a Codex Sinaiticus page on a 

white background. 
Test image of a Codex Sinaiticus page on a 

black background. 

Through testing, the decision was made to opt for a compromise colour. A light 
brown background was chosen that was close enough to the colour of the 
parchment to give a sense of its warmth, while reducing the show-through to a 
point where it rarely makes reading the page difficult. 

 

See a list of the digitisation experts in the Codex Sinaiticus Project. 
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